Table of Contents

EasyVR 3 Module ........................................................................................................................................ 6
  Product Description ................................................................................................................................. 6
  EasyVR 3 Features ................................................................................................................................. 6
Technical specifications ............................................................................................................................. 7
  Pin assignment ......................................................................................................................................... 8
  Settings and indicators ............................................................................................................................ 9
  Physical dimensions .............................................................................................................................. 9
  Recommended Operating Conditions ..................................................................................................... 10
  Power Supply Requirements .................................................................................................................. 10
  Electrical Characteristics ....................................................................................................................... 10
  Serial Interface ....................................................................................................................................... 11
  Microphone ........................................................................................................................................... 12
  Audio Output .......................................................................................................................................... 14
  General Purpose I/O ............................................................................................................................... 15
  Flash Update .......................................................................................................................................... 16
Quick start guide for using the module ..................................................................................................... 17
  Assembly notes ....................................................................................................................................... 17
  EasyVR 3 as a Development Board ....................................................................................................... 18

EasyVR Shield 3 for Arduino .................................................................................................................... 20
  Product description................................................................................................................................ 20
    EasyVR Shield 3 Features ..................................................................................................................... 20
Technical specifications ............................................................................................................................. 21
  Board overview ....................................................................................................................................... 21
  Pin assignment ....................................................................................................................................... 22
  Mode Jumper settings ............................................................................................................................ 23
  Software Serial Pins settings ................................................................................................................ 23
Quick start guide for using the Shield ........................................................................................................ 24
  Assembly notes ....................................................................................................................................... 24
  Prepare the software .............................................................................................................................. 25
  Prepare the hardware ............................................................................................................................. 25
  Shield configuration table ...................................................................................................................... 26
  Test the Shield on Arduino ..................................................................................................................... 26
  Test the Shield from the EasyVR Commander ....................................................................................... 27
  Download custom data or Firmware update .......................................................................................... 27

EasyVR Programming ................................................................................................................................. 28
  Communication Protocol ....................................................................................................................... 28
    Introduction ......................................................................................................................................... 28
    Arguments Mapping ........................................................................................................................... 29
    Command Details .............................................................................................................................. 30
    Status Details ..................................................................................................................................... 37
Communication Examples ........................................................................................................................... 40
  Recommended wake up procedure ........................................................................................................ 40
  Recommended setup procedure ............................................................................................................. 40
  Recognition of a built-in or custom SI command .................................................................................. 41
  Adding a new SD command ................................................................................................................... 41
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Training an SD command</td>
<td>42</td>
</tr>
<tr>
<td>Recognition of an SD command</td>
<td>42</td>
</tr>
<tr>
<td>Read used command groups</td>
<td>43</td>
</tr>
<tr>
<td>Read how many commands in a group</td>
<td>43</td>
</tr>
<tr>
<td>Read a user defined command group</td>
<td>43</td>
</tr>
<tr>
<td>Use general purpose I/O pins</td>
<td>44</td>
</tr>
<tr>
<td>Use custom sound playback</td>
<td>44</td>
</tr>
<tr>
<td>Read sound table</td>
<td>44</td>
</tr>
<tr>
<td>Built-in Command Sets</td>
<td>45</td>
</tr>
<tr>
<td>Error codes</td>
<td>46</td>
</tr>
<tr>
<td>Protocol header file</td>
<td>47</td>
</tr>
<tr>
<td><strong>EasyVR Arduino Library</strong></td>
<td>49</td>
</tr>
<tr>
<td>EasyVR library settings</td>
<td>49</td>
</tr>
<tr>
<td>Macros</td>
<td>49</td>
</tr>
<tr>
<td>Detailed Description</td>
<td>49</td>
</tr>
<tr>
<td>Macro Definition Documentation</td>
<td>49</td>
</tr>
<tr>
<td>EasyVR Class Reference</td>
<td>50</td>
</tr>
<tr>
<td>Public Types</td>
<td>50</td>
</tr>
<tr>
<td>Public Member Functions</td>
<td>50</td>
</tr>
<tr>
<td>Detailed Description</td>
<td>51</td>
</tr>
<tr>
<td>Member Enumeration Documentation</td>
<td>51</td>
</tr>
<tr>
<td>Constructor &amp; Destructor Documentation</td>
<td>56</td>
</tr>
<tr>
<td>Member Function Documentation</td>
<td>56</td>
</tr>
<tr>
<td><strong>EasyVR Commander</strong></td>
<td>69</td>
</tr>
<tr>
<td>Getting Started</td>
<td>69</td>
</tr>
<tr>
<td>Remote Connections (Advanced Topic)</td>
<td>70</td>
</tr>
<tr>
<td>Configuring the Remote System</td>
<td>70</td>
</tr>
<tr>
<td>Configuring the EasyVR Commander</td>
<td>71</td>
</tr>
<tr>
<td>Speech Recognition</td>
<td>72</td>
</tr>
<tr>
<td>Recognition Settings</td>
<td>74</td>
</tr>
<tr>
<td>Phone Tones Generation (DTMF)</td>
<td>75</td>
</tr>
<tr>
<td>Testing SonicNet™</td>
<td>76</td>
</tr>
<tr>
<td>Real-Time Lip-Sync</td>
<td>78</td>
</tr>
<tr>
<td>Import and Export of Custom Commands</td>
<td>78</td>
</tr>
<tr>
<td>Using Custom Data</td>
<td>79</td>
</tr>
<tr>
<td>Sound Table</td>
<td>79</td>
</tr>
<tr>
<td>Speaker Independent Custom Vocabularies</td>
<td>80</td>
</tr>
<tr>
<td>Updating Custom Data</td>
<td>81</td>
</tr>
<tr>
<td>Message Recording</td>
<td>83</td>
</tr>
<tr>
<td>Updating Firmware</td>
<td>84</td>
</tr>
<tr>
<td>Important Upgrade Notice</td>
<td>84</td>
</tr>
<tr>
<td><strong>QuickUSB Adapter Cable</strong></td>
<td>85</td>
</tr>
<tr>
<td>Product Description</td>
<td>85</td>
</tr>
<tr>
<td>QuickUSB Features</td>
<td>85</td>
</tr>
<tr>
<td>Technical Specifications</td>
<td>85</td>
</tr>
<tr>
<td>Drawings and Schematics</td>
<td>85</td>
</tr>
<tr>
<td>Pin Description</td>
<td>85</td>
</tr>
<tr>
<td>Operating Conditions</td>
<td>86</td>
</tr>
<tr>
<td>Electrical Characteristics</td>
<td>86</td>
</tr>
</tbody>
</table>
## Document History Information

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>2015/01/27</td>
<td>• Initial draft</td>
</tr>
<tr>
<td>1.0.3</td>
<td>2015/02/09</td>
<td>• New drawings and updated descriptions</td>
</tr>
<tr>
<td>1.0.4</td>
<td>2015/03/19</td>
<td>• Added new pictures and minor updates</td>
</tr>
<tr>
<td>1.0.5</td>
<td>2015/03/25</td>
<td>• Updated pictures and quick-start sections</td>
</tr>
<tr>
<td>1.0.6</td>
<td>2015/03/30</td>
<td>• Added programming and library chapters</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added PC software description</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Updated pictures and layout</td>
</tr>
<tr>
<td>1.0.7</td>
<td>2015/03/31</td>
<td>• Minor corrections</td>
</tr>
<tr>
<td>1.0.8</td>
<td>2015/04/01</td>
<td>• Updated custom data screenshots and description</td>
</tr>
<tr>
<td>1.0.9</td>
<td>2015/04/02</td>
<td>• Added chapter for QuickUSB adapter</td>
</tr>
<tr>
<td>1.0.10</td>
<td>2015/04/22</td>
<td>• Updated mechanical drawing of module</td>
</tr>
<tr>
<td>1.0.11</td>
<td>2015/06/05</td>
<td>• Added note about soldering headers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Removed old logo from drawings</td>
</tr>
<tr>
<td>1.0.12</td>
<td>2015/07/02</td>
<td>• Updated QuickT2SI screenshots</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added notes about message recording functions</td>
</tr>
<tr>
<td>1.0.13</td>
<td>2016/03/10</td>
<td>• Added J7 pin-out numbering on module picture</td>
</tr>
<tr>
<td>1.0.14</td>
<td>2016/08/02</td>
<td>• Fixed protocol description</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added missing protocol elements</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Updated Arduino library documentation</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Updated EasyVR Commander with new interface elements</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Updated product features</td>
</tr>
<tr>
<td>1.0.15</td>
<td>2017/03/20</td>
<td>• Added configuration table for EasyVR Shield operating modes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added advanced topic for remote connections</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Updated quick start guides</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Updated products pictures</td>
</tr>
<tr>
<td>1.0.16</td>
<td>2018/04/05</td>
<td>• Updated EasyVR features to latest firmware revision</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added firmware upgrade notice</td>
</tr>
</tbody>
</table>
EasyVR 3 Module

Product Description

EasyVR 3 is a multi-purpose speech recognition module designed to easily add versatile, robust and cost effective speech recognition capabilities to almost any application.

The EasyVR 3 module can be used with any host with an UART interface powered at 3.3V - 5V, such as PIC and Arduino boards. Some application examples include home automation, such as voice controlled light switches, locks, curtains or kitchen appliances, or adding “hearing” to the most popular robots on the market.

It can be easily plugged into a solder-less breadboard or standard prototyping board, and it is compatible with the mikroBUS™ specifications (see www.mikroe.com/mikrobos).

Separate male headers are provided inside the package, along with a microphone cable assembly and speaker wires (loudspeaker not included).

EasyVR 3 Features

- Up to 28 custom Speaker Independent (SI) command vocabularies.
  Supported Languages:
  - US English
  - British English
  - French
  - German
  - Italian
  - Japanese
  - Korean
  - Mandarin
  - Spanish
- Up to 64 user-defined Speaker Dependent (SD) or Speaker Verification (SV) commands, that can be trained in ANY language, divided into maximum 16 groups (up to 32 SD or 5 SV commands each).
- A selection of built-in Speaker Independent (SI) commands for ready-to-run basic controls, in the following languages:
  - English (US)
  - Italian
  - German
  - French
  - Spanish
  - Japanese
- SonicNet™ technology for wireless communications between modules or any other sound source (Audio CD, DVD, MP3 Player).
- Up to around 21 minutes of pre-recorded sounds or speech.
- Up to about 100 seconds of live message recording and playback.
- Real-time Lip-sync capability.
- DTMF tone generation.
- Differential audio output that directly supports 8Ω speakers.
- Easy-to-use Graphical User Interface to program Voice Commands and audio.
- Standard UART interface (powered at 3.3V - 5V).
- Simple and robust documented serial protocol to access and program through the host board.
- 6 General purpose I/O lines that can be controlled via UART commands.

1 A QuickT2SI™ Lite license (sold separately) is required to enable creation of Speaker Independent vocabularies (maximum 12 commands per set). No license required to use SI grammars.
2 At the maximum compression rate.
The outer headers J1 and J2 are the mikroBUS™ interface connectors, providing selectable 3.3V/5V power input to the module and voltage translated digital I/O lines, including: UART receive/transmit lines and control pins.

The header J3 provides configurable I/O expansion lines (inputs with weak internal pull-up by default), powered at the internal logic voltage VDD.

The header J4 contains the main analog signals, such as microphone signals and amplified DAC outputs, which are also available on the internal right angle connectors J5 and J6.

The module can also be operated through the programming connector J7 alone, by using the QuickUSB Adapter Cable.
<table>
<thead>
<tr>
<th>Group</th>
<th>Name</th>
<th>Number</th>
<th>Pin</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MIKROBUS</td>
<td>J1</td>
<td>1</td>
<td>-</td>
<td>-</td>
<td>(Not connected)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2</td>
<td>RST</td>
<td>I</td>
<td>Active low asynchronous reset (internal pull-up)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3-6</td>
<td>-</td>
<td>-</td>
<td>(Not connected)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7</td>
<td>3V3</td>
<td>I</td>
<td>3.3V DC power input</td>
</tr>
<tr>
<td></td>
<td></td>
<td>8</td>
<td>GND</td>
<td>-</td>
<td>Ground</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1</td>
<td>XM</td>
<td>I</td>
<td>Boot select (internal pull-down)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2</td>
<td>DE</td>
<td>O</td>
<td>(Reserved)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3</td>
<td>TX</td>
<td>O</td>
<td>Serial Data Transmit</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4</td>
<td>RX</td>
<td>I</td>
<td>Serial Data Receive</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5-6</td>
<td>-</td>
<td>-</td>
<td>(Not connected)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7</td>
<td>5V</td>
<td>I</td>
<td>5.0V DC power input</td>
</tr>
<tr>
<td></td>
<td></td>
<td>8</td>
<td>GND</td>
<td>-</td>
<td>Ground</td>
</tr>
<tr>
<td>GPIO</td>
<td>J3</td>
<td>1</td>
<td>IO1</td>
<td>I/O</td>
<td>General purpose I/O (VDD logic levels)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2</td>
<td>IO2</td>
<td>I/O</td>
<td>General purpose I/O (VDD logic levels)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3</td>
<td>IO3</td>
<td>I/O</td>
<td>General purpose I/O (VDD logic levels)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4</td>
<td>IO4</td>
<td>I/O</td>
<td>General purpose I/O (VDD logic levels)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5</td>
<td>IO5</td>
<td>I/O</td>
<td>General purpose I/O (VDD logic levels)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>6</td>
<td>IO6</td>
<td>I/O</td>
<td>General purpose I/O (VDD logic levels)</td>
</tr>
<tr>
<td>AUDIO</td>
<td>J4</td>
<td>1</td>
<td>SP+</td>
<td>O</td>
<td>Differential audio output (can directly drive 8Ω speaker)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2</td>
<td>SP-</td>
<td>O</td>
<td>Differential audio output (can directly drive 8Ω speaker)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3</td>
<td>VM</td>
<td>O</td>
<td>Microphone power (to support custom microphones)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4</td>
<td>MIC</td>
<td>I</td>
<td>Microphone audio input</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5</td>
<td>RET</td>
<td>-</td>
<td>Microphone return (analog ground)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>6</td>
<td>VDD</td>
<td>O</td>
<td>Internal logic voltage (for reference only)</td>
</tr>
<tr>
<td>CABLES</td>
<td>J5</td>
<td>1</td>
<td>SP-</td>
<td>O</td>
<td>Differential audio output (can directly drive 8Ω speaker)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2</td>
<td>-</td>
<td>-</td>
<td>(Not connected)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3</td>
<td>SP+</td>
<td>O</td>
<td>Differential audio output (can directly drive 8Ω speaker)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1</td>
<td>MIC</td>
<td>I</td>
<td>Microphone audio input</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2</td>
<td>RET</td>
<td>-</td>
<td>Microphone return (analog ground)</td>
</tr>
<tr>
<td>ADAPTER</td>
<td>J6</td>
<td>1</td>
<td>RX_P</td>
<td>O</td>
<td>Programming cable serial data receive</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2</td>
<td>RTS_P</td>
<td>I</td>
<td>Programming cable request to send (reset/boot control)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3</td>
<td>GND</td>
<td>-</td>
<td>Programming cable ground</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4</td>
<td>5V_P</td>
<td>I</td>
<td>Programming cable 5V DC power output</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5</td>
<td>TX_P</td>
<td>I</td>
<td>Programming cable serial data transmit</td>
</tr>
<tr>
<td></td>
<td></td>
<td>6</td>
<td>CTS_P</td>
<td>O</td>
<td>Programming cable clear to send (tied to ground)</td>
</tr>
</tbody>
</table>
Note: The General Purpose I/O lines (J3.1-6) are at nominal 3.0VDC level. Do not connect higher voltages directly to these pins!

**Settings and indicators**

<table>
<thead>
<tr>
<th>Group</th>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>PWR SEL</td>
<td>3-Way Jumper</td>
<td>Select power input and voltage level between +3.3V and +5V with a zero Ohm resistor or solder bridge</td>
</tr>
<tr>
<td>MISC</td>
<td>D1</td>
<td>LED</td>
<td>Red light indicator, normally ON when the board is powered, briefly blinking on serial data received</td>
</tr>
<tr>
<td></td>
<td>D2</td>
<td>LED</td>
<td>Green light indicator, turns ON when the module is listening to its audio input</td>
</tr>
<tr>
<td></td>
<td>R4</td>
<td>Resistor</td>
<td>Microphone gain resistor, default is 1.2kΩ</td>
</tr>
</tbody>
</table>

**Physical dimensions**

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Parameter</th>
<th>Units (mm / Inches)</th>
</tr>
</thead>
<tbody>
<tr>
<td>W</td>
<td>Width</td>
<td>25.4 / 1.000</td>
</tr>
<tr>
<td>L</td>
<td>Length</td>
<td>56.4 / 2.220</td>
</tr>
<tr>
<td>H₁</td>
<td>Height (without outer strips J1-J4)</td>
<td>9.5 / 0.375</td>
</tr>
<tr>
<td>H₂</td>
<td>Height (with outer strips J1-J4)</td>
<td>17.0 / 0.670</td>
</tr>
<tr>
<td>E₁</td>
<td>Connector pitch and pin spacing (of outer strips J1-J4)</td>
<td>2.54 / 0.100</td>
</tr>
<tr>
<td>E₂</td>
<td>Connector pitch (of inner connectors J5-J7)</td>
<td>2.00 / 0.079</td>
</tr>
<tr>
<td>A</td>
<td>Headers horizontal spacing</td>
<td>22.86 / 0.900</td>
</tr>
<tr>
<td>B</td>
<td>Headers vertical spacing</td>
<td>20.32 / 0.800</td>
</tr>
<tr>
<td>C</td>
<td>Header vertical offset</td>
<td>3.81 / 0.150</td>
</tr>
<tr>
<td>D</td>
<td>Header horizontal offset</td>
<td>1.27 / 0.050</td>
</tr>
</tbody>
</table>
### Recommended Operating Conditions

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Parameter</th>
<th>Min</th>
<th>Typ</th>
<th>Max</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>5V</td>
<td>DC Power Input (Host) = ( V_{\text{SEL}} )</td>
<td>3.15</td>
<td>5.0</td>
<td>5.5</td>
<td>V</td>
</tr>
<tr>
<td>3V3</td>
<td></td>
<td>3.15</td>
<td>3.3</td>
<td>5.5</td>
<td>V</td>
</tr>
<tr>
<td>5V_P</td>
<td>DC Power Input (Programming cable)</td>
<td>4.0</td>
<td>5.0</td>
<td>5.5</td>
<td>V</td>
</tr>
<tr>
<td>Ta</td>
<td>Ambient Operating Temperature Range</td>
<td>0</td>
<td>25</td>
<td>70</td>
<td>°C</td>
</tr>
</tbody>
</table>

### Power Supply Requirements

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Parameter</th>
<th>Min</th>
<th>Typ</th>
<th>Max</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>( I_{\text{SLEEP}} )</td>
<td>Sleep current (( V_{\text{SEL}} = 5.0V ))</td>
<td>6</td>
<td></td>
<td></td>
<td>mA</td>
</tr>
<tr>
<td>( I_{\text{OPER}} )</td>
<td>Operating current (( V_{\text{SEL}} = 5.0V ))</td>
<td>25</td>
<td>35</td>
<td></td>
<td>mA</td>
</tr>
<tr>
<td>( I_{\text{AUDIO}} )</td>
<td>Audio playback current (with 8Ω speaker)</td>
<td>175</td>
<td>250</td>
<td></td>
<td>mA_{(\text{RMS})}</td>
</tr>
<tr>
<td>( I_{\text{TOT}} )</td>
<td>Total current consumption (excluding I/O)</td>
<td>25</td>
<td>285</td>
<td></td>
<td>mA_{(\text{RMS})}</td>
</tr>
<tr>
<td>( I_{\text{PEAK}} )</td>
<td>Peak supply current (excluding I/O)</td>
<td>400</td>
<td></td>
<td></td>
<td>mA</td>
</tr>
</tbody>
</table>

### Electrical Characteristics

These are applicable to pins RX, TX, P.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Parameter</th>
<th>Min</th>
<th>Typ</th>
<th>Max</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>( V_{\text{IH}} )</td>
<td>Input High Voltage</td>
<td>2.1</td>
<td>5.5</td>
<td></td>
<td>V</td>
</tr>
<tr>
<td>( V_{\text{IL}} )</td>
<td>Input Low Voltage</td>
<td>0.0</td>
<td>0.9</td>
<td></td>
<td>V</td>
</tr>
<tr>
<td>( I_{\text{IL}} )</td>
<td>Input Leakage Current (( 0 &lt; V_I &lt; 5.5V ))</td>
<td>-65</td>
<td></td>
<td></td>
<td>µA</td>
</tr>
</tbody>
</table>

These are applicable to pins TX, DE.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Parameter</th>
<th>Min</th>
<th>Typ</th>
<th>Max</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>( V_{\text{OH}} )</td>
<td>Output High Voltage</td>
<td>2.6</td>
<td>3.3</td>
<td></td>
<td>V</td>
</tr>
<tr>
<td>( V_{\text{OL}} )</td>
<td>Output Low Voltage</td>
<td>0.0</td>
<td>0.2</td>
<td></td>
<td>V</td>
</tr>
</tbody>
</table>

These are applicable to pin XM.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Parameter</th>
<th>Min</th>
<th>Typ</th>
<th>Max</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>( V_{\text{IH}} )</td>
<td>Input High Voltage</td>
<td>1.4</td>
<td>(0.8)</td>
<td>5.5</td>
<td>V</td>
</tr>
<tr>
<td>( V_{\text{IL}} )</td>
<td>Input Low Voltage</td>
<td>0.0</td>
<td>(0.7)</td>
<td>0.5</td>
<td>V</td>
</tr>
<tr>
<td>( I_{\text{IN}} )</td>
<td>Input Current (( 0 &lt; V_I &lt; 3.3V ))</td>
<td>0</td>
<td>0.2</td>
<td>0.4</td>
<td>mA</td>
</tr>
<tr>
<td></td>
<td>Input Current (( 0 &lt; V_I &lt; 5.5V ))</td>
<td>0</td>
<td>0.5</td>
<td>0.7</td>
<td>mA</td>
</tr>
</tbody>
</table>

These are applicable to pin RST.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Parameter</th>
<th>Min</th>
<th>Typ</th>
<th>Max</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>( V_{\text{IH}} )</td>
<td>Input High Voltage</td>
<td>2.1</td>
<td>5.5</td>
<td></td>
<td>V</td>
</tr>
<tr>
<td>( V_{\text{IL}} )</td>
<td>Input Low Voltage</td>
<td>0.0</td>
<td>0.6</td>
<td></td>
<td>V</td>
</tr>
<tr>
<td>( I_{\text{IL}} )</td>
<td>Input Leakage Current (( 0 &lt; V_I &lt; 5.5V ))</td>
<td>-85</td>
<td></td>
<td></td>
<td>µA</td>
</tr>
</tbody>
</table>
These are applicable to pin RX_P.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Parameter</th>
<th>Min</th>
<th>Typ</th>
<th>Max</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$V_{\text{OH}}$</td>
<td>Output High Voltage ($I_{\text{OH}} = -5 \text{ mA}$)</td>
<td>2.4</td>
<td>3.0</td>
<td>V</td>
<td></td>
</tr>
<tr>
<td>$V_{\text{OL}}$</td>
<td>Output Low Voltage ($I_{\text{OL}} = 8 \text{ mA}$)</td>
<td>0.0</td>
<td>0.6</td>
<td>V</td>
<td></td>
</tr>
</tbody>
</table>

These are applicable to pins IO1 - IO6.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Parameter</th>
<th>Min</th>
<th>Typ</th>
<th>Max</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$V_{\text{IH}}$</td>
<td>Input High Voltage</td>
<td>2.4</td>
<td>3.0</td>
<td>3.3</td>
<td>V</td>
</tr>
<tr>
<td>$V_{\text{IL}}$</td>
<td>Input Low Voltage</td>
<td>-0.1</td>
<td>0.0</td>
<td>0.75</td>
<td>V</td>
</tr>
<tr>
<td>$I_{\text{IL}}$</td>
<td>Input Leakage Current ($0 &lt; V_i &lt; 3 \text{ V}, \text{ Hi-Z Input}$)</td>
<td>&lt;1</td>
<td>10</td>
<td>µA</td>
<td></td>
</tr>
<tr>
<td>$R_{\text{PU}}$</td>
<td>Pull-up Resistance</td>
<td>Strong</td>
<td>10</td>
<td>kΩ</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Weak</td>
<td>200</td>
<td>kΩ</td>
<td></td>
</tr>
<tr>
<td>$V_{\text{OH}}$</td>
<td>Output High Voltage ($I_{\text{OH}} = -5 \text{ mA}$)</td>
<td>2.4</td>
<td>3.0</td>
<td>V</td>
<td></td>
</tr>
<tr>
<td>$V_{\text{OL}}$</td>
<td>Output Low Voltage ($I_{\text{OL}} = 8 \text{ mA}$)</td>
<td>0.0</td>
<td>0.6</td>
<td>V</td>
<td></td>
</tr>
</tbody>
</table>

**Serial Interface**

The EasyVR 3 communicates via an asynchronous serial interface (commonly known as UART interface), with the following features:

- Baud Rate: 9600 (default), 19200, 38700, 57600, 115200
- Frame: 8 Data bits, No parity, 1 Stop bit

The receiver input data line is RX, while the transmitter output data line is TX. No handshake lines are used.

Example of a serial data frame representing character “A” (decimal 65 or hexadecimal 41):

```
VCC

Idle Start 1 0 0 0 0 0 1 0 Stop Idle
0V
```

See also chapter *Communication Protocol* later on this manual for communication details.
Microphone

The microphone provided with the EasyVR 3 module is an omnidirectional electret condenser microphone (Horn EM9745P-382):

- Sensitivity -38dB (0dB=1V/Pa @1KHz)
- Load Impedance 2.2K
- Operating Voltage 3V
- Almost flat frequency response in the range 100Hz - 20kHz

The microphone circuit is optimized for use at ARMS_LENGTH (default, about 60cm) or FAR_MIC distance settings.

If you use a microphone with different specifications the recognition accuracy may be adversely affected. Differences in rated load impedance and sensitivity can be compensated to a certain extent by changing the microphone gain. This can be done in several ways:

- Replacing the internal gain resistor R4 (1.2kΩ)
- Adding an external resistor Rx going in parallel with R4 (it can only reduce gain, useful for HEADSET distance settings)
- Removing the internal resistor R4 and using only the external resistor Rx

![Microphone circuit](image)

Modifying gain resistance

You can calculate the overall microphone gain resistance using the formula below:

\[ R_s = I \times \frac{G-S}{20} \]

- \( R_s \) is the optimal microphone gain resistance
- \( I \) is the impedance rating of the microphone
- \( G \) is the desired overall system gain, defined as follows:

1. If the module is configured for HEADSET microphone distance (typically a few centimeters from the user’s mouth), then the overall system gain should be -49 dB (0dB=1V/Pa@1KHz);
2. If the module is configured for ARMS_LENGTH microphone distance (typically 60-90 cm from the user’s mouth - this is the default setting of EasyVR), then the overall system gain should be -44 dB;
3. If the module is configured for FAR_MIC microphone distance (up to about 3 meters from the user’s mouth), then the overall system gain should be -43 dB.

\( S \) is the sensitivity rating of the microphone you want to use, and it is specified in -dB in the microphone’s specification.

---

3 Converting μBars to Pascal: microphone manufacturers specify the sensitivity referencing to μBars or Pascal. If the microphone sensitivity is referenced to μBars, simply add 20 dB to the rating. For example, -58 dB/μBars + 20dB = -38 dBV/Pa.
Examples

1) The optimal gain resistance for the bundled microphone at ARMS_LENGTH distance is:

\[ R_s = 2200 \times 10^\left(-\frac{44}{20}\right) = 1103 \]

Use the closest standard 5% resistor to Rs. In this example, it would be 1.1 kΩ. The EasyVR uses a 1.2 kΩ resistor to allow use of “FAR” settings without replacing the internal resistor. Sometimes you might also need to compensate some gain loss for a voltage lower than the microphone ratings (using a larger resistor value sets a higher input gain).

2) The gain resistance for the bundled microphone at HEADSET distance would be:

\[ R_s = 2200 \times 10^\left(-\frac{49}{20}\right) = 620 \]

In this case you may just add an external 1.2 kΩ resistor to get a gain resistance of 600 Ω (close enough).

Positioning guidelines

Please note that improper acoustic positioning of the microphone will reduce recognition accuracy. Many mechanical arrangements are possible for the microphone element, and some will work better than others. When mounting the microphone in the final device, keep in mind the following guidelines:

1. **Flush Mounting** - The microphone element should be positioned as close to the mounting surface as possible and should be fully seated in the plastic housing. There must be no airspace between the microphone element and the housing. Having such airspace can lead to acoustic resonance, which can reduce recognition accuracy.

2. **No Obstructions, Large Hole** - The area in front of the microphone element must be kept clear of obstructions to avoid interference with recognition. The diameter of the hole in the housing in front of the microphone should be at least 5 mm. Any necessary plastic surface in front of the microphone should be as thin as possible, being no more than 0.7 mm, if possible.

3. **Insulation** - The microphone should be acoustically isolated from the housing if possible. This can be accomplished by surrounding the microphone element with a spongy material such as rubber or foam. The provided microphone has this kind of insulating foam. The purpose is to prevent...
auditory noises produced by handling or jarring the device from being “picked up” by the microphone. Such extraneous noises can reduce recognition accuracy.

4. **Distance** - If the microphone is moved from 15 cm to 30 cm from the speaker’s mouth, the signal power decreases by a factor of four. The difference between a loud and a soft voice can also be more than a factor of four. Although the internal preamplifier of the EasyVR compensates for a wide dynamic range of input signal strength, if its range is exceeded, the user application can provide feedback to the speaker about the voice volume (see appendix *Error codes*).

**Audio Output**

The EasyVR 3 audio output interface is capable of directly driving an 8Ω speaker. It can also be connected to an external audio amplifier to drive lower impedance loudspeakers.

**Note:** Connecting speakers with lower impedance directly to the module may permanently damage the EasyVR audio output or the whole module.

It is possible to connect higher impedance loads such as headphones, provided that you scale down the output power according to the speaker ratings, for example using a series resistor. The exact resistor value depends on the headphone sensitivity and the desired output volume (usually in the order of 1-10kΩ).

**Note:** Connecting headphone speakers directly to the EasyVR audio output may damage your hearing.
General Purpose I/O

Since the EasyVR communication interface takes two pins of the host controller, a few spare I/O pins are provided, which can be controlled with the communication protocol, to get those pins back for basic tasks, such as lighting an LED or reading a switch.

The six I/O pins IO1-IO6 are connected directly to the embedded microcontroller on the EasyVR module, so they are referenced to the internal 3.0V regulated power supply VDD. If you need to interface to circuits using a different supply, there are a number of solutions you can adopt. Some of these are outlined below (here IOn indicates any one of the six I/O pins of the EasyVR).

Use a pin as an output

All the I/O pins are inputs with weak internal pull-up after power on. You must explicitly configure a pin before you can use it as an output (see the example code Use general purpose I/O pins).

<table>
<thead>
<tr>
<th>I/O pin directly driving a low-current LED</th>
<th>I/O pin connected to high impedance 5V circuit (such as MCU input pin)</th>
<th>I/O pin switching a load on a high voltage line using a 12V relay</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Pin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IOn</td>
<td>LED</td>
</tr>
</tbody>
</table>

The exact components values in these circuits may vary. You need to calculate required values for your application and choice of components. For example, resistor value for the LED circuit can be calculated approximately as:

\[
R_{LED} = \frac{V_{OH} - V_{LED}}{I_{OH}}
\]

Where \(V_{LED}\) is the LED forward voltage, as reported on the LED datasheet, at the driving current \(I_{OH}\) (see section Electrical Characteristics). Let’s assume a typical low-current LED has a \(V_f=1.8\)V at 5mA, the resistor value is:

\[
R_{LED} = \frac{2.4 - 1.8}{0.005} = 120 Ohm
\]

Now stay on the safe side and choose a slightly larger resistor, such as 150Ω.

If you want to drive higher current LEDs, you need a circuit like the second one, where you put the LED between the output resistor and the collector of the NPN transistor.

Use a pin as an input

All the I/O pins are inputs with weak internal pull-up after power on or reset. You may also configure the pin to have a strong pull-up or no pull-up at all (see the example code Use general purpose I/O pins).
All these circuits assume the EasyVR pin has been configured with an internal pull-up (passive components value can be adjusted to account for weak or strong pull-up).

Disabling the internal pull-up could be used to put the pin in high-impedance state, for example to simulate a tri-state or open-drain output port.

Again, you should refer to the manufacturer’s datasheet when interfacing any external components and to calculate required resistors values or other passive components.

**Flash Update**

The EasyVR module includes a boot loader that allows to update the firmware and to download new sound tables or custom grammars to the on-board memory.

The *boot mode* is activated by keeping the XM signal to a high logical level at power on or reset. This can be easily done with a jumper (or switch) taking the signal to a suitable pull-up resistor.

To download a firmware update, a sound table or a custom grammar to the EasyVR, power on the module with the jumper closed. For normal operation, just leave the jumper open. Do not change the jumper position while the module is already powered on. It is safe to change XM level while the module is reset (RST low).

To learn how to download new sound tables or custom grammars to your EasyVR 3 module, have a look at the section *Using Custom Data*. 
Quick start guide for using the module

Assembly notes

The EasyVR 3 is provided with separate standard 2.54mm-pitch male headers that can be used to connect the module to a breadboard, prototyping board, custom boards or carrier boards like the EasyVR Shield 3.

When male headers are necessary, make sure they are well soldered on the module in order to prevent electrical issues.

Some practical guides to hand soldering:

- Adafruit Guide To Excellent Soldering
- Sparkfun How to Solder: Through-Hole Soldering

When assembling the module, especially in preparation for the EasyVR Shield 3, make sure you insert male headers from the bottom side and solder them on the top side, and that all the headers are straight and vertical for a smooth insertion on the carrier board.

The end result should be similar to the following pictures:
EasyVR 3 as a Development Board

The EasyVR 3 module has been designed to allow use as a standalone development board when combined with a USB-Serial adapter.

The QuickUSB adapter cable can be used to program voice commands and sound outputs directly to an EasyVR 3 module and quickly test its functions from your PC.

Just connect the microphone and an 8Ω speaker to the module, plug-in the adapter cable and you are ready to go.

The EasyVR 3 boot mode is managed automatically through the serial handshake lines and you don’t need to set any jumper.

Getting started

1. Connect the microphone to the 2-way socket MIC (J6)
2. Connect an 8Ω speaker to the 3-way socket SPEAKER (J5)
3. Connect a QuickUSB cable to the 3x2 pins socket (J7)
4. Plug the USB end of the adapter cable to your PC.
   The first time it may take some time to install the required drivers (see Software Setup)
5. If your installation is successful you will see a new virtual COM port in your Device Manager:

(The actual COM port number may vary)

6. Now start the EasyVR Commander software
7. Choose your COM Port and click connect
8. Then enjoy your EasyVR!
Serial Adapter Interface

Connector J7 is a 6-pin socket specifically designed for the QuickUSB serial adapter cable, but another adapter may also be connected to this port, as long as it uses the same connector type, pin assignment and electrical specifications.

<table>
<thead>
<tr>
<th>Pin</th>
<th>Name</th>
<th>Type</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>RX_P</td>
<td>I</td>
<td>Adapter should have TTL/LVTTL compatible inputs ($V_{IH} = 2.0V$)</td>
</tr>
<tr>
<td>2</td>
<td>RTS_P</td>
<td>O</td>
<td>Adapter outputs can have 3.3V or 5V levels. RTS handshake is required for automatic reset and boot mode control</td>
</tr>
<tr>
<td>3</td>
<td>GND</td>
<td>-</td>
<td>Common ground</td>
</tr>
<tr>
<td>4</td>
<td>5V_P</td>
<td>O</td>
<td>Adapter should provide a 5V DC power output for the module. (see Recommended Operating Conditions and Power Supply Requirements)</td>
</tr>
<tr>
<td>5</td>
<td>TX_P</td>
<td>O</td>
<td>Adapter outputs can have 3.3V or 5V levels</td>
</tr>
<tr>
<td>6</td>
<td>CTS_P</td>
<td>I</td>
<td>CTS is tied to GND on the module</td>
</tr>
</tbody>
</table>

Connector type is Hirose DF11 Series (female on the adapter cable, male on the module).

---

Please note that pin direction here is referring to the external adapter.
EasyVR Shield 3 for Arduino

Product description

The EasyVR Shield 3 is an adapter board for the EasyVR 3 module, designed to simplify its use among the Arduino community.

The Shield is compatible with any Arduino board using UNO-R3 Shield headers, running at either 3.3V or 5V levels, by using the IOREF pin to select the EasyVR operating voltage.

It is also backward compatible with earlier Arduino boards that don’t have the IOREF pin, which are using 5V I/O levels by default.

If your board does not have the IOREF pin but it is running at 3.3V, you can still operate the EasyVR Shield 3 correctly if you manually connect pins IOREF and 3V3 together, for example with a jumper wire.

The board comes with separate Arduino stackable headers for the Shield interface. The EasyVR 3 module is also provided separately.

Note: The EasyVR 3 module and all stackable headers must be soldered before use!

EasyVR Shield 3 Features

- Compatible with Arduino boards that have the 1.0 Shield interface (UNO R3) including, but not limited to:
  - Arduino Zero
  - Arduino Uno
  - Arduino Mega
  - Arduino Leonardo
  - Arduino Due
- Supports 5V and 3.3V main boards through the IOREF pin (defaults to 5V if this pin is absent)
- Supports direct connection to the PC on main boards with a separate USB/Serial chip and a special software-driven “bridge mode” on boards with only native USB interface, for easy access and configuration with the EasyVR Commander
- Enables different modes of serial connection and also flash updates to the embedded EasyVR module (through the Mode Jumper)
- Supports remapping of serial pins used by the Shield (in SW mode)
- Provides a 3.5mm audio output jack suitable for headphones or as a line out
Technical specifications

Board overview
### Pin assignment

<table>
<thead>
<tr>
<th>Group</th>
<th>Pin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ARDUINO HEADERS</strong></td>
<td>-</td>
<td>Arduino UNO-R3 Shield interface, pass-through connectors</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Pins 0-1 are in use when J12 is set to UP, PC, HW or LEO)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Pins 12-13 or 8-9 are in use when J12 is set to SW)</td>
</tr>
<tr>
<td><strong>EASYVR AUDIO</strong></td>
<td>-</td>
<td>Audio cables connectors of the EasyVR 3 module (microphone and speaker)</td>
</tr>
<tr>
<td><strong>LINE OUT</strong></td>
<td>-</td>
<td>3.5mm stereo/mono jack (16Ω - 32Ω headphones or line-level output)</td>
</tr>
<tr>
<td><strong>MODE JUMPER</strong></td>
<td>SW</td>
<td>Arduino Software Serial (connected to pins 12-13 or 8-9)</td>
</tr>
<tr>
<td></td>
<td>HW</td>
<td>Arduino Hardware Serial (connected to pins 0-1)</td>
</tr>
<tr>
<td></td>
<td>PC</td>
<td>PC Mode (Arduino disabled, EasyVR in command mode)</td>
</tr>
<tr>
<td></td>
<td>UP</td>
<td>Update Mode (Arduino disabled, EasyVR in boot mode)</td>
</tr>
<tr>
<td></td>
<td>LEO</td>
<td>Leonardo Update (Arduino enabled, EasyVR in boot mode)</td>
</tr>
<tr>
<td><strong>PROG</strong></td>
<td>-</td>
<td>Red light indicator for Flash programming modes (UP and LEO)</td>
</tr>
<tr>
<td><strong>SW SERIAL PINS</strong></td>
<td>RX</td>
<td>Use resistor to select Software Serial RX pin: 12 or 8</td>
</tr>
<tr>
<td></td>
<td>TX</td>
<td>Use resistor to select Software Serial TX pin: 13 or 9</td>
</tr>
<tr>
<td><strong>EASYVR GPIO</strong></td>
<td>IO1</td>
<td>General purpose I/O as found on the embedded EasyVR 3 module (referenced at the internal VDD logic level - see note below)</td>
</tr>
<tr>
<td></td>
<td>IO2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>IO3</td>
<td></td>
</tr>
<tr>
<td></td>
<td>IO4</td>
<td></td>
</tr>
<tr>
<td></td>
<td>IO5</td>
<td></td>
</tr>
<tr>
<td></td>
<td>IO6</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** The General Purpose I/O lines (IO1-IO6) are at nominal 3.0VDC level. Do not connect higher voltages directly to these pins!
Mode Jumper settings

This jumper selects the operating mode of the EasyVR Shield and it can be placed in one of four positions:

- **SW - Software Serial mode**
  Use it for controlling the EasyVR module from your Arduino sketch through a software serial port (using pins 12-13). You can also connect the EasyVR Commander in this mode, provided that the running sketch implements bridge mode (see the Arduino library examples).

- **HW - Hardware Serial mode**
  Use it for controlling the EasyVR module from your Arduino sketch through the hardware serial port (using pins 0-1).

- **PC - PC Connection mode**
  Use it for direct connection with the EasyVR Commander. In this mode, the Arduino controller is held in reset and only the embedded USB/Serial adapter is used.

- **UP - Flash Update mode**
  Use it for firmware updates or to download sound table data and custom grammars to the onboard flash memory from the EasyVR Commander. In this mode, the Arduino controller is held in reset and only the embedded USB/Serial adapter is used. The EasyVR module is set in boot mode.

- **LEO - Leonardo Update mode**
  This is similar to the regular Flash Update mode, for Arduino boards that don’t have a separate USB/Serial adapter, such as Arduino Leonardo. The EasyVR module is set in boot mode, but the Arduino controller is not reset and it must be running the special “bridge” sketch.

Software Serial Pins settings

On the bottom side of the board there are two SMD resistors that you can move to select the two pins of Arduino that the EasyVR will be connected to when in Software Serial mode (Mode Jumper on SW).

- **RX - Software Serial Receiver pin**
  - D12 - Use digital pin 12 as serial receiver (default)
  - D8 - Use digital pin 8 as serial receiver

- **TX - Software Serial Transmitter pin**
  - D13 - Use digital pin 13 as serial transmitter (default)
  - D9 - Use digital pin 9 as serial transmitter

The choice of pins 12-13 is maintained for backward compatibility with the previous hardware revisions of the EasyVR Shield. However those pins may also be used for the SPI interface, so another choice of pins 8-9 is provided. If you want to use different pins make sure the receiver pin supports change interrupts.
Quick start guide for using the Shield

Assembly notes

The EasyVR Shield 3 is provided with separate through-hole headers to connect the Shield to Arduino boards and other microcontroller-based boards adopting an Arduino compatible interface.

The EasyVR 3 module is provided separately and it should be fully assembled before it is soldered on top of the Shield. Make sure they are both well soldered in order to prevent electrical issues (see highlighted areas in the picture below).

Some practical guides to hand soldering:
- Adafruit Guide To Excellent Soldering
- Sparkfun How to Solder: Through-Hole Soldering

Before you mount the EasyVR 3 module on the top, make sure you have assembled the pass-through headers on the EasyVR Shield 3 in the correct position and orientation. It is easier if you place all the connectors through the Shield with their plastic housings faced down on your desk, so that they can stand straight and vertical, and allow soldering of the metal leads easily from the back side of the board, which is now facing up.

As the last step, insert an already assembled EasyVR 3 module on its reserved footprint on the Shield, make sure it is plugged all the way in, and then complete soldering of male headers on the bottom side.

The end result should be similar to the following pictures:

Note: Pay attention to the tail of male headers (red areas) on the bottom of the EasyVR 3 module when you plug the Shield on a base board and make sure they are not touching other metal parts or connectors. If necessary you can trim the tails to prevent undesired contacts.
Prepare the software

1. Install the EasyVR Commander, available on the VeeaR website:
2. Install a recent version of the Arduino IDE, available from the official Arduino community:
3. Install the EasyVR Arduino libraries[^1] on your PC.
   You can use the “Library Manager” in recent versions of the Arduino IDE to automatically download and install the latest version of the library.
   In alternative, to perform a manual install see:

![Manual installation of Arduino library]

Prepare the hardware

1. Insert the EasyVR Shield on top of your Arduino board
2. If you want audio output, either wire an 8Ω speaker into the SPEAKER connector (J5) on the EasyVR module or connect headphones or amplified speakers to the LINE OUT 3.5mm audio jack on the Shield
3. Connect the supplied microphone to the MIC connector (J6) on the EasyVR module
4. Make sure the Mode Jumper (J7) is in the correct position (see table below)
5. Connect a USB cable from your PC to the appropriate USB port for your Arduino board (see table below)

[^1]: The Arduino library archive file can also be found in the EasyVR Commander program folder.
Shield configuration table

Each Arduino board requires the correct combination of jumper settings and USB port, according to the operating mode and usage of the Shield.

The EasyVR Shield can be configured to support several operating modes using the Mode Jumper (J7) and the special “bridge mode” software provided by the EasyVR Arduino library and included in all the example sketches.

There are three main operating modes:

1. **Arduino Sketch**
   The Shield can connect the EasyVR module to either the first Hardware Serial port on pins 0/1 or a Software Serial port on pins 8/9 or 12/13 (default).
   The example sketches will auto-configure the library to use the default settings in the table below, but customization is possible within some constraints.
   The Mode Jumper can be in the HW or SW position (sketch running normally).

2. **EasyVR Commander**
   Some Arduino main boards have a second controller with a USB/Serial adapter that can be used for direct connection to the EasyVR module from the PC.
   Some boards have a native USB interface, or have a serial adapter which is not routed to the first Hardware Serial port. In those cases the “bridge” code running on the Arduino controller can soft-connect the EasyVR module to the PC.
   The Mode Jumper can be in the PC position (sketch not running) or the HW or SW position (sketch running the “bridge” software).

3. **Download / Update**
   This is similar to the above, except that the EasyVR module is configured to enter “boot mode” at power on or reset.
   The Mode Jumper can be in the UP position (sketch not running) or LEO position (sketch running the “bridge” software).

Each board should also be connected to the correct on-board USB port (when more are available), which is used by the example sketches to provide feedback on the “Monitor Window” and to run the “bridge” software for the EasyVR Commander.

Supported combinations are detailed in the table below:

<table>
<thead>
<tr>
<th>Main Board</th>
<th>Arduino Sketch</th>
<th>EasyVR Commander</th>
<th>Download / Update</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Mode Jumper</td>
<td>USB Port</td>
<td>Mode Jumper</td>
</tr>
<tr>
<td>Arduino Zero / M0 Pro</td>
<td>HW Programming</td>
<td>HW Programming</td>
<td>LEO Programming</td>
</tr>
<tr>
<td>Arduino Uno / Mega / 2009</td>
<td>SW Monitor</td>
<td>SW / PC Monitor</td>
<td>UP Monitor</td>
</tr>
<tr>
<td>Arduino Leonardo / Due</td>
<td>HW Native</td>
<td>HW Native</td>
<td>LEO Native</td>
</tr>
<tr>
<td>Arduino Due</td>
<td>HW Native</td>
<td>PC Programming</td>
<td>UP Programming</td>
</tr>
</tbody>
</table>

**Test the Shield on Arduino**

1. Select your Arduino board from Arduino IDE menu “Tools” > “Board” and the correct serial port (both choices must match the on-board USB port you have connected)
2. Open and upload the example sketch “TestEasyVR” from the Arduino IDE menu
3. Open the “Serial Monitor” window at 9600 bps
4. Send a question mark “?” (without quotes) and after a few seconds you should receive an “EasyVR detected” message, along with a summary of the module configuration
5. See the comments on top of the sketch for usage details and other tests you can perform

Other examples are also included with the library, to test special features of the EasyVR module.
Test the Shield from the EasyVR Commander

1. Select your Arduino board from Arduino IDE menu “Tools” > “Board” and the correct serial port (both choices must match the on-board USB port you have connected).
2. Open and upload the example sketch “TestEasyVR” or “EasyVRBridge” from the Arduino IDE menu “File” > “Examples” > “EasyVR”
3. Make sure the “Serial Monitor” window is not open in the Arduino IDE.
4. Open the EasyVR Commander and connect to the same serial port used by Arduino.

When the EasyVR Commander is connected, you can also generate a template code for Arduino that will use the provided libraries (see EasyVR Arduino Library Documentation). All you need is to write actions for each recognized command.

Download custom data or Firmware update

1. Follow the same steps for the EasyVR Commander above, but make sure to adjust the Mode Jumper settings for your main board (see table above) and that the PROG red LED is on.
2. While the EasyVR Commander is disconnected choose “Update Custom Data” from the “File” menu or “Update firmware” from the “Help” menu.
EasyVR Programming

Communication Protocol

Introduction

Communication with the EasyVR module uses a standard UART interface compatible with 3.3-5V TTL/CMOS logical levels, according to the powering voltage VCC.

A typical connection to an MCU-based host:

![EasyVR Connection Diagram]

The initial configuration at power on is 9600 baud, 8 bit data, No parity, 1 bit stop. The baud rate can be changed later to operate in the range 9600 - 115200 baud.

The communication protocol only uses printable ASCII characters, which can be divided in two main groups:

- Command and status characters, respectively on the TX and RX lines, chosen among lower-case letters.
- Command arguments or status details, again on the TX and RX lines, spanning the range of capital letters.

Each command sent on the TX line, with zero or more additional argument bytes, receives an answer on the RX line in the form of a status byte followed by zero or more arguments.

There is a minimum delay before each byte sent out from the EasyVR module to the RX line, that is initially set to 20 ms and can be selected later in the ranges 0 - 9 ms, 10 - 90 ms, and 100 ms - 1 s. That accounts for slower or faster host systems and therefore suitable also for software-based serial communication (bit-banging) or communication proxies/bridges.

Since the EasyVR serial interface also is software-based, a very short delay might be needed before transmitting a character to the module, especially if the host is very fast, to allow the EasyVR to get back listening to a new character.

The communication is host-driven and each byte of the reply to a command has to be acknowledged by the host to receive additional status data, using the space character. The reply is aborted if any other character is received and so there is no need to read all the bytes of a reply if not required.

Invalid combinations of commands or arguments are signaled by a specific status byte, that the host should be prepared to receive if the communication fails. Also a reasonable timeout should be used to recover from unexpected failures.

If the host does not send all the required arguments of a command, the command is ignored by the module, without further notification, and the host can start sending another command.

The module automatically goes to lowest power sleep mode after power on. To initiate communication, send any character to wake-up the module.
Arguments Mapping

Command or status messages sent over the serial link may have one or more numerical arguments in the range -1 to 31, which are encoded using mostly characters in the range of uppercase letters. These are some useful constants to handle arguments easily:

**ARG_MIN**

| 'ɶ' (40h) | Minimum argument value (-1) |

**ARG_MAX**

| '`' (60h) | Maximum argument value (+31) |

**ARG_ZERO**

| 'A' (41h) | Zero argument value (0) |

**ARG_ACK**

| ' ' (20h) | Read more status arguments |

Having those constants defined in your code can simplify the validity checks and the encoding/decoding process. For example (in pseudo-code):

```
# encode value 5
FIVE = 5 + ARG_ZERO
# decode value 5
FIVE - ARG_ZERO = 5
# validity check
IF ARG < ARG_MIN OR ARG > ARG_MAX THEN ERROR
```

Just to make things clearer, here is a table showing how the argument mapping works:

<table>
<thead>
<tr>
<th>ASCII</th>
<th>@</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>...</th>
<th>Y</th>
<th>Z</th>
<th>^</th>
<th>[</th>
<th>\</th>
<th>]</th>
<th>_</th>
<th>`</th>
</tr>
</thead>
<tbody>
<tr>
<td>HEX</td>
<td>40</td>
<td>41</td>
<td>42</td>
<td>43</td>
<td>...</td>
<td>59</td>
<td>5A</td>
<td>5B</td>
<td>5C</td>
<td>5D</td>
<td>5E</td>
<td>5F</td>
<td>60</td>
</tr>
<tr>
<td>Value</td>
<td>-1</td>
<td>0</td>
<td>1</td>
<td>2</td>
<td>...</td>
<td>24</td>
<td>25</td>
<td>26</td>
<td>27</td>
<td>28</td>
<td>29</td>
<td>30</td>
<td>31</td>
</tr>
</tbody>
</table>
**Command Details**

This section describes the format of all the command strings accepted by the module. Please note that numeric arguments of command requests are mapped to upper-case letters (see above section).

Some commands share the same lower case letter, because there were no command identifiers available when the protocol has been expanded, but the first argument is used to discriminate.

### CMD_BREAK

<table>
<thead>
<tr>
<th>'b' (62h)</th>
<th>Abort recognition, training or playback in progress if any or do nothing</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Known issues:</strong></td>
<td>In firmware ID 0, any other character received during recognition will prevent this command from stopping recognition that will continue until timeout or other recognition results.</td>
</tr>
<tr>
<td><strong>Expected replies:</strong></td>
<td>STS_SUCCESS, STS_INTERR, STS_AWAKEN (if sleeping)</td>
</tr>
</tbody>
</table>

### CMD_SLEEP

<table>
<thead>
<tr>
<th>'s' (73h)</th>
<th>Go to the specified power-down mode</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sleep mode (0-8):</strong></td>
<td>0 = wake on received character only 1 = wake on whistle or received character 2 = wake on loud sound or received character 3-5 = wake on double clap (with varying sensitivity) or received character 6-8 = wake on triple clap (with varying sensitivity) or received character</td>
</tr>
<tr>
<td><strong>Expected replies:</strong></td>
<td>STS_SUCCESS</td>
</tr>
</tbody>
</table>

### CMD_ID

<table>
<thead>
<tr>
<th>'x' (78h)</th>
<th>Request firmware identification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Expected replies:</strong></td>
<td>STS_ID</td>
</tr>
</tbody>
</table>

### CMD_DELAY

<table>
<thead>
<tr>
<th>'y' (79h)</th>
<th>Set transmit delay</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Time (0-10 = 0-10 ms, 11-19 = 20-100 ms, 20-28 = 200-1000 ms)</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Expected replies:</strong></td>
<td>STS_SUCCESS</td>
</tr>
</tbody>
</table>

### CMD_BAUDRATE

<table>
<thead>
<tr>
<th>'a' (61h)</th>
<th>Set communication baud-rate</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Speed mode:</strong></td>
<td>1 = 115200 2 = 57600 3 = 38400 6 = 19200 12 = 9600</td>
</tr>
<tr>
<td><strong>Expected replies:</strong></td>
<td>STS_SUCCESS</td>
</tr>
</tbody>
</table>
### CMD_LEVEL

<table>
<thead>
<tr>
<th>'v' (76h)</th>
<th>Set SD level</th>
</tr>
</thead>
</table>
| [1]       | Strictness control setting (1-5):  
           | 1 = easy  
           | 2 = default  
           | 5 = hard  
           | A higher setting will result in more recognition errors. |

**Expected replies:** STS_SUCCESS

### CMD_KNOB

<table>
<thead>
<tr>
<th>'k' (6Bh)</th>
<th>Set SI knob to specified level</th>
</tr>
</thead>
</table>
| [1]       | Confidence threshold level (0-4):  
           | 0 = loosest: more valid results  
           | 2 = typical value (default)  
           | 4 = tightest: fewer valid results |
| Note: knob is ignored for trigger words |

**Expected replies:** STS_SUCCESS

### CMD_MIC_DIST

<table>
<thead>
<tr>
<th>'k' (6Bh)</th>
<th>Set the microphone operating distance</th>
</tr>
</thead>
</table>
| [1]       | Fixed to (-1)  
           | Distance settings (1-3):  
           | 1 = “headset” (around 5cm from speaker’s mouth)  
           | 2 = “arm’s length” (default setting, from about 50cm to 1m)  
           | 3 = “far mic” (up to around 3m) |

**Expected replies:** STS_SUCCESS

### CMD_TRAILING

<table>
<thead>
<tr>
<th>'t' (74h)</th>
<th>Set trailing silence for SI recognition</th>
</tr>
</thead>
</table>
| [1]       | Fixed to (-1)  
           | Amount of silence at the end of an utterance (0-31):  
           | 0 = 100ms  
           | ... in steps of 25ms  
           | 31 = 875ms |

**Expected replies:** STS_SUCCESS

### CMD_FAST_SD

<table>
<thead>
<tr>
<th>'f' (66h)</th>
<th>Set fast operating mode for SD/SV recognition</th>
</tr>
</thead>
</table>
| [1]       | Fixed to (-1)  
           | Operating mode (0 = normal/default, 1 = fast/low-latency) |

**Expected replies:** STS_TOKEN, STS_TIMEOUT
# CMD_LANGUAGE

- **'I' (6Ch)**: Set SI language
  - Language:
    - 0 = English
    - 1 = Italian
    - 2 = Japanese
    - 3 = German
    - 4 = Spanish
    - 5 = French
  - **Expected replies**: STS_SUCCESS

# CMD_TIMEOUT

- **'O' (6Fh)**: Set recognition timeout
  - Timeout (-1 = default, 0 = infinite, 1-31 = seconds)
  - **Expected replies**: STS_SUCCESS

# CMD_RECOG_SI

- **'I' (69h)**: Activate SI recognition from specified word set
  - Word set index (0-3)
  - **Expected replies**: STS_SIMILAR, STS_TIMEOUT, STS_ERROR

# CMD_TRAIN_SD

- **'T' (74h)**: Train specified SD/SV command
  - Group index (0 = trigger, 1-15 = generic, 16 = password)
  - Command position (0-31)
  - **Expected replies**: STS_SUCCESS, STS_RESULT, STS_SIMILAR, STS_TIMEOUT, STS_ERROR

# CMD_GROUP_SD

- **'G' (67h)**: Insert new SD/SV command
  - Group index (0 = trigger, 1-15 = generic, 16 = password)
  - Position (0-31)
  - **Expected replies**: STS_SUCCESS, STS_OUT_OF_MEM

# CMD_UNGROUP_SD

- **'U' (75h)**: Remove SD/SV command
  - Group index (0 = trigger, 1-15 = generic, 16 = password)
  - Position (0-31)
  - **Expected replies**: STS_SUCCESS
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Arguments</th>
<th>Expected Replies</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMD_RECOG_SD</td>
<td>Activate SD/SV recognition</td>
<td>Group index (0 = trigger, 1-15 = generic, 16 = password)</td>
<td>STS_RESULT, STS_SIMILAR, STS_TIMEOUT, STS_ERROR</td>
</tr>
<tr>
<td>CMD_ERASE_SD</td>
<td>Erase training of SD/SV command</td>
<td>Group index (0 = trigger, 1-15 = generic, 16 = password), Command position (0-31)</td>
<td>STS_SUCCESS</td>
</tr>
<tr>
<td>CMD_NAME_SD</td>
<td>Label SD/SV command</td>
<td>Group index (0 = trigger, 1-15 = generic, 16 = password), Command position (0-31), Length of label (0-31), Text for label (ASCII characters from 'A' to `)</td>
<td>STS_SUCCESS</td>
</tr>
<tr>
<td>CMD_COUNT_SD</td>
<td>Request count of SD/SV commands in the specified group</td>
<td>Group index (0 = trigger, 1-15 = generic, 16 = password)</td>
<td>STS_COUNT</td>
</tr>
<tr>
<td>CMD_DUMP_SD</td>
<td>Read SD/SV command data (label and training)</td>
<td>Group index (0 = trigger, 1-15 = generic, 16 = password), Command position (0-31)</td>
<td>STS_DATA</td>
</tr>
<tr>
<td>CMD_MASK_SD</td>
<td>Request bit-mask of non-empty groups</td>
<td></td>
<td>STS_MASK</td>
</tr>
<tr>
<td>CMD_RESETALL</td>
<td>Reset all (erase commands/groups and messages)</td>
<td>Confirmation character</td>
<td>STS_SUCCESS</td>
</tr>
</tbody>
</table>
CMD_RESET_SD

'\textit{r} \ (72h) \quad \text{Reset only commands and groups}

'D \ (52h) \quad \text{Confirmation character}

\textbf{Expected replies: \textit{STS_SUCCESS}}

CMD_RESET_RP

'\textit{r} \ (72h) \quad \text{Reset only message recordings}

'M \ (52h) \quad \text{Confirmation character}

\textbf{Expected replies: \textit{STS_SUCCESS}}

CMD_QUERY_IO

'q' \ (71h) \quad \text{Configure, query or modify general purpose I/O pins}

\begin{itemize}
  \item \[1\] \quad \text{Pin number (1 = pin IO1, 2 = pin IO2, 3 = pin IO3)}
  \item \[2\] \quad \text{Pin mode (0 = output low, 1 = output high, 2 = input*, 3 = input strong**, 4 = input weak***)}
    \quad \quad * \quad \text{High impedance input (no pull-up)}
    \quad \quad ** \quad \text{Strong means \textasciitilde 10K internal pull-up}
    \quad \quad *** \quad \text{Weak means \textasciitilde 200K internal pull-up (default after power up)}
\end{itemize}

\textbf{Expected replies: \textit{STS_SUCCESS}} (mode 0-1), \textit{STS_PIN} (mode 2-4)

CMD_PLAY_SX

'w' \ (77h) \quad \text{Wave table entry playback}

\begin{itemize}
  \item \[1-2\] \quad \text{Two positive values that form a 10-bit index to the sound table (index = \[1\] * 32 + \[2\], 0 = built-in “beep”, 1-1023 = sound index)}
  \item \[3\] \quad \text{Playback volume (0-31, 0 = min volume, 15 = full scale, 31 = double gain)}
\end{itemize}

\textbf{Expected replies: \textit{STS_SUCCESS}, \textit{STS_ERROR}}

CMD_PLAY_DTMF

'w' \ (77h) \quad \text{Play a DTMF key tone or dial tone}

\begin{itemize}
  \item \[1\] \quad \text{Fixed to (-1)}
  \item \[2\] \quad \text{Index of phone tone to play (0-9 for digits, 10 for ’*’ key, 11 for ’#’ key and 12-15 for extra keys ‘A’ to ’D’, -1 for the dial tone)}
  \item \[3\] \quad \text{Tone duration minus 1 (0-31 in 40ms units for keys, in seconds for the dial tone)}
\end{itemize}

\textbf{Expected replies: \textit{STS_SUCCESS}}

CMD_DUMP_SX

'h' \ (68h) \quad \text{Read wave table data}

\textbf{Expected replies: \textit{STS_TABLE_SX}, \textit{STS_OUT_OF_MEM}}
**CMD_DUMP_SI**

<table>
<thead>
<tr>
<th>'z' (7Ah)</th>
<th>Read custom and built-in grammars data</th>
</tr>
</thead>
<tbody>
<tr>
<td>[1]</td>
<td>Index of SI grammar to read (0-31) or (-1) to get the total count of SI grammars (including the first 4 built-in word sets)</td>
</tr>
</tbody>
</table>

**Expected replies:** STS_GRAMMAR, STS_COUNT

**CMD_SEND_SN**

<table>
<thead>
<tr>
<th>'j' (6Ah)</th>
<th>Send a SonicNet™ token</th>
</tr>
</thead>
<tbody>
<tr>
<td>[1]</td>
<td>Length of token (4 or 8 in bits)</td>
</tr>
<tr>
<td>[2-3]</td>
<td>Two positive values that form an 8-bit token index (index = [2] * 32 + [3], 0-15 for 4-bit tokens or 0-255 for 8-bits tokens)</td>
</tr>
<tr>
<td>[4-5]</td>
<td>Two positive values that form a 10-bit delay for token output since the next sound playback (delay = [4] * 32 + [5], 0 = send immediately, 1-1023 = delay in units of 27.46ms)</td>
</tr>
</tbody>
</table>

**Expected replies:** STS_SUCCESS

**CMD_RECV_SN**

<table>
<thead>
<tr>
<th>'f' (66h)</th>
<th>Receive a SonicNet™ token</th>
</tr>
</thead>
<tbody>
<tr>
<td>[1]</td>
<td>Length of token (4 or 8 in bits)</td>
</tr>
<tr>
<td>[2]</td>
<td>Rejection level (0-2 = higher values mean fewer results, 1 = default)</td>
</tr>
<tr>
<td>[3-4]</td>
<td>Two positive values that form a 10-bit timeout for token detection (timeout = [3] * 32 + [4], 0 = wait forever, 1-1023 = timeout in units of 27.46ms)</td>
</tr>
</tbody>
</table>

**Expected replies:** STS_TOKEN, STS_TIMEOUT

**CMD_LIPSINC**

<table>
<thead>
<tr>
<th>'l' (6Ch)</th>
<th>Start real-time lip-sync</th>
</tr>
</thead>
<tbody>
<tr>
<td>[1]</td>
<td>Fixed to (-1)</td>
</tr>
<tr>
<td>[4-5]</td>
<td>Timeout option (8-bit value = [4] * 16 + [5]): 0 = no timeout (can be interrupted) 1-255 = duration in seconds</td>
</tr>
</tbody>
</table>

**Expected replies:** STS_LIPSINC

**CMD_RECORD_RP**

<table>
<thead>
<tr>
<th>'r' (72h)</th>
<th>Record a message</th>
</tr>
</thead>
<tbody>
<tr>
<td>[1]</td>
<td>Fixed to (-1)</td>
</tr>
<tr>
<td>[3]</td>
<td>Data format (8)</td>
</tr>
<tr>
<td>[4]</td>
<td>Timeout option (0-31): 0 = no timeout (can be interrupted) 1-31 = duration in seconds</td>
</tr>
</tbody>
</table>

**Expected replies:** STS_SUCCESS, STS_ERROR
## CMD_PLAY_RP

<table>
<thead>
<tr>
<th>'p' (70h)</th>
<th>Play a message recording</th>
</tr>
</thead>
<tbody>
<tr>
<td>[1] Fixed to (-1)</td>
<td></td>
</tr>
</tbody>
</table>
  - Bit 2 (4) = playback speed (0 = normal, 1 = fast)  
  - Bit 1-0 (0-3) = volume attenuation (0 = normal, 1 = -2.2dB, 2 = -4.5dB, 3 = -6.7dB) |

Expected replies: STS_SUCCESS, STS_ERROR

## CMD_ERASE_RP

<table>
<thead>
<tr>
<th>'e' (65h)</th>
<th>Erase a message recording</th>
</tr>
</thead>
<tbody>
<tr>
<td>[1] Fixed to (-1)</td>
<td></td>
</tr>
</tbody>
</table>

Expected replies: STS_SUCCESS, STS_ERROR

## CMD_VERIFY_RP

<table>
<thead>
<tr>
<th>'v' (76h)</th>
<th>Verify file-system integrity for message recordings</th>
</tr>
</thead>
<tbody>
<tr>
<td>[1] Fixed to (-1)</td>
<td></td>
</tr>
</tbody>
</table>
| [2] Type of operation:  
  - 0 = check only  
  - 1 = check and fix errors |

Expected replies: STS_SUCCESS, STS_ERROR

## CMD_SERVICE + SVC_EXPORT_SD

<table>
<thead>
<tr>
<th>'X' (58h)</th>
<th>Export command raw data</th>
</tr>
</thead>
<tbody>
<tr>
<td>[1] Group index (0 = trigger, 1-15 = generic, 16 = password)</td>
<td></td>
</tr>
<tr>
<td>[2] Command position (0-31)</td>
<td></td>
</tr>
</tbody>
</table>

Expected replies: STS_SUCCESS, SVC_DUMP_SD

## CMD_SERVICE + SVC_IMPORT_SD

<table>
<thead>
<tr>
<th>'I' (49h)</th>
<th>Import command raw data</th>
</tr>
</thead>
<tbody>
<tr>
<td>[1] Group index (0 = trigger, 1-15 = generic, 16 = password)</td>
<td></td>
</tr>
<tr>
<td>[2] Command position (0-31)</td>
<td></td>
</tr>
<tr>
<td>[3-514] Raw command data (encoded as hex nibbles - byte = [n] * 16 + [n+1])</td>
<td></td>
</tr>
<tr>
<td>[515-518] Data checksum (16-bit sum of all 256 bytes, starting at 1234h)</td>
<td></td>
</tr>
</tbody>
</table>

Expected replies: STS_SUCCESS, STS_INTERR (if checksum fails)
**CMD_SERVICE + SVC_VERIFY_SD**

| '−' (7Eh) | Service protocol expansion |
| 'V' (56h) | Verify command raw data |
| [1] | Group index (0 = trigger, 1-15 = generic, 16 = password) |
| [2] | Command position (0-31) |

**Expected replies:** STS_SUCCESS, STS_RESULT, STS_SIMILAR, STS_ERROR

### Status Details

Replies to commands follow this format. Please note that numeric arguments of status replies are mapped to upper-case letters (see the related section).

#### STS_MASK

| 'k' (6Bh) | Mask of non-empty groups |
| [1-8] | 4-bit values that form 32-bit mask, LSB first |

**In reply to:** CMD_MASK_SD

#### STS_COUNT

| 'c' (63h) | Count of commands or total number of SI grammars |
| [1] | Integer (0-31 = command/grammar count, -1 = 32 commands/grammars) |

**In reply to:** CMD_COUNT_SD, CMD_DUMP_SI

#### STS_AWAKEN

| 'w' (77h) | Wake-up (back from power-down mode) |

**In reply to:** Any character after power on or sleep mode

#### STS_DATA

| 'd' (64h) | Provide command data |
| [1] | Training information (-1=empty, 1-6 = training count, +8 = SD/SV conflict, +16 = SI conflict) |
| Known issues: |
| In firmware ID 0, command creation/deletion might cause other empty commands training count to change to 7. Treat count values of -1, 0 or 7 as empty training markers. Never train commands more than 2 or 3 times. |
| [2] | Conflicting command position (0-31, only meaningful when trained) |
| [3] | Length of label (0-31) |
| [4-n] | Text of label (ASCII characters from 'A' to `) |

**Known issues:**

EasyVR Commander encodes digits 0-9 as A-J prefixed by '^'.

**In reply to:** CMD_DUMP_SD

#### STS_ERROR

| 'e' (65h) | Signal recognition error |
| [1-2] | Two positive values that form an 8-bit error code (error = [1] * 16 + [2], see appendix) |

**In reply to:** CMD_RECOG_SI, CMD_RECOG_SD, CMD_TRAIN_SD, CMD_PLAY_SX
<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>In reply to</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>STS_INVALID</code></td>
<td><img src="image" alt="Invalid command or argument" /></td>
<td>Any invalid command or argument</td>
</tr>
<tr>
<td><code>STS_TIMEOUT</code></td>
<td><img src="image" alt="Timeout expired" /></td>
<td>CMD_RECOG_SI, CMD_RECOG_SD, CMD_TRAIN_SD</td>
</tr>
<tr>
<td><code>STS_LIPSYNC</code></td>
<td><img src="image" alt="Lip-sync streaming data" /></td>
<td>CMD_LIPSYNC</td>
</tr>
<tr>
<td><code>STS_INTERR</code></td>
<td><img src="image" alt="Interrupted recognition" /></td>
<td>CMD_BREAK while in training, recognition or playback</td>
</tr>
<tr>
<td><code>STS_SUCCESS</code></td>
<td><img src="image" alt="OK or no errors status" /></td>
<td>CMD_BREAK, CMD_DELAY, CMD_BAUDRATE, CMD_TIMEOUT, CMD_KNOB, CMD_LEVEL, CMD_LANGUAGE, CMD_SLEEP, CMD_GROUP_SD, CMD_UNGROUP_SD, CMD_ERASE_SD, CMD_NAME_SD, CMD_RESETALL, CMD_QUERY_IO, CMD_PLAY_SX, etc.</td>
</tr>
<tr>
<td><code>STS_RESULT</code></td>
<td><img src="image" alt="Recognized SD/SV command or Training similar to SD/SV command" /></td>
<td>CMD_RECOG_SD, CMD_TRAIN_SD</td>
</tr>
<tr>
<td><code>STS_SIMILAR</code></td>
<td><img src="image" alt="Recognized SI word or Training similar to SI word" /></td>
<td>CMD_RECOG_SI, CMD_RECOG_SD, CMD_TRAIN_SD</td>
</tr>
<tr>
<td><code>STS_OUT_OF_MEM</code></td>
<td><img src="image" alt="Memory error (no more room for commands or sound table not present)" /></td>
<td>CMD_GROUP_SD, CMD_DUMP_SX</td>
</tr>
</tbody>
</table>
### STS_ID

<table>
<thead>
<tr>
<th>'x' (78h)</th>
<th>Provide firmware identification</th>
</tr>
</thead>
<tbody>
<tr>
<td>[1]</td>
<td>Version identifier (0)</td>
</tr>
</tbody>
</table>

In reply to: **CMD_ID**

### STS_PIN

<table>
<thead>
<tr>
<th>'p' (70h)</th>
<th>Provide pin input status</th>
</tr>
</thead>
<tbody>
<tr>
<td>[1]</td>
<td>Logic level (0 = input low, 1 = input high)</td>
</tr>
</tbody>
</table>

In reply to: **CMD_QUERY_IO**

### STS_TABLE_SX

<table>
<thead>
<tr>
<th>'d' (64h)</th>
<th>Provide sound table data</th>
</tr>
</thead>
<tbody>
<tr>
<td>[1-2]</td>
<td>Two positive values that form a 10-bit count of entries in the sound table (count = [1] * 32 + [2])</td>
</tr>
<tr>
<td>[3]</td>
<td>Length of table name (0-31)</td>
</tr>
<tr>
<td>[4-n]</td>
<td>Text of table name (ASCII characters from 'A' to '')</td>
</tr>
</tbody>
</table>

In reply to: **CMD_DUMP_SX**

### STS_GRAMMAR

<table>
<thead>
<tr>
<th>'z' (7Ah)</th>
<th>Provide custom grammar data</th>
</tr>
</thead>
<tbody>
<tr>
<td>[1]</td>
<td>Some flags for this grammar (currently 16 is returned for trigger grammars, 0 for commands)</td>
</tr>
<tr>
<td>[2]</td>
<td>Number of commands in this grammar (0-31)</td>
</tr>
<tr>
<td>[3]</td>
<td>Length of first command label (0-31)</td>
</tr>
<tr>
<td>[4-n]</td>
<td>Text of first command label (ASCII characters from 'A' to '')</td>
</tr>
</tbody>
</table>

... Repeat last two fields for all the commands in this grammar

In reply to: **CMD_DUMP_SI**

### STS_TOKEN

<table>
<thead>
<tr>
<th>'f' (66h)</th>
<th>Detected a SonicNet™ token</th>
</tr>
</thead>
<tbody>
<tr>
<td>[1-2]</td>
<td>Two positive values that form the index of a received token (index = [1] * 32 + [2], 0-15 for 4-bit tokens or 0-255 for 8-bits tokens)</td>
</tr>
</tbody>
</table>

In reply to: **CMD_RECV_SN**

### STS_SERVICE + SVC_DUMP_SD

<table>
<thead>
<tr>
<th>'-' (7Eh)</th>
<th>Service protocol expansion</th>
</tr>
</thead>
<tbody>
<tr>
<td>'D' (44h)</td>
<td>Provide command raw data</td>
</tr>
<tr>
<td>[1-512]</td>
<td>Raw command data (encoded as hex nibbles - byte = [n] * 16 + [n+1])</td>
</tr>
<tr>
<td>[513-516]</td>
<td>Data checksum (16-bit sum of all 256 bytes, starting at 1234h)</td>
</tr>
</tbody>
</table>

In reply to: **CMD_SERVICE + SVC_EXPORT_SD**
Communication Examples

These are some examples of actual command and status characters exchanged with the EasyVR module by host programs and the expected program flow with pseudo-code sequences.

The pseudo-instruction SEND transmits the specified character to the module, while RECEIVE waits for a reply character (a timeout is not explicitly handled for simple commands, but should be always implemented if possible).

Also, the OK and ERROR routines are not explicitly defined, since they are host and programming language dependent, but appropriate code should be written to handle both conditions. Lines beginning with a # (sharp) character are comments.

Please note that in a real programming language it would be best to define some constants for the command and status characters, as well as for mapping numeric arguments, that would be used throughout the program, to minimize the chance of repetition errors and clarify the meaning of the code.

See the Protocol header file for sample definitions that can be used in a C language environment.

Here below all the characters sent and received are written explicitly in order to clarify the communication protocol detailed in the previous sections.

Recommended wake up procedure

```plaintext
# wake up or interrupt recognition or do nothing
# (uses a timeout or max repetition count)
DO
    SEND 'b'
LOOP UNTIL RECEIVE = 'o'
```

Recommended setup procedure

```plaintext
# ask firmware id
SEND 'x'
IF NOT RECEIVE = 'x' THEN ERROR

# send ack and read status (expecting id=0)
SEND '

id = RECEIVE
IF id = 'A' THEN
    # it's a VRbot
ELSE IF id = 'B' THEN
    # it's an EasyVR
ELSE
    # next generation?
END IF

# set language for SI recognition (Japanese)
SEND 'l'
SEND 'C'
IF RECEIVE = 'o' THEN OK ELSE ERROR

# set timeout (5 seconds)
SEND 'o'
SEND 'F'
IF RECEIVE = 'o' THEN OK ELSE ERROR
```
Recognition of a built-in or custom SI command

```plaintext
# start recognition in wordset 1
SEND 'i'
SEND 'B'
# wait for reply:
# (if 5s timeout has been set, wait for max 6s then abort
# otherwise trigger recognition could never end)
result = RECEIVE

IF result = 's' THEN
    # successful recognition, ack and read result
    SEND ' ' 
    command = RECEIVE - 'A'
    # perform actions according to command
ELSE IF result = 't' THEN
    # timed out, no word spoken
ELSE IF result = 'e' THEN
    # error code, ack and read which one
    error = (RECEIVE - 'A') * 16
    SEND ' '
    error = error + (RECEIVE - 'A')
    # perform actions according to error
ELSE
    # invalid request or reply
    ERROR
END IF
```

Adding a new SD command

```plaintext
# insert command 0 in group 3
SEND 'g'
SEND 'D'
SEND 'A'
IF RECEIVE = 'o' THEN OK ELSE ERROR

# set command label to "ARDUINO_2009"
SEND 'g'
SEND 'D'
SEND 'A'
SEND 'Q'
# name length (16 characters, digits count twice)
SEND 'A'
SEND 'R'
SEND 'D'
SEND 'U'
SEND 'I'
SEND 'O'
SEND '_'
# encode each digit with a ^ prefix
# followed by the digit mapped to upper case letters
SEND '^'
SEND 'C'
SEND '^'
SEND 'A'
SEND '^'
SEND 'A'
SEND '^'
SEND 'J'
IF RECEIVE = 'o' THEN OK ELSE ERROR
```
Training an SD command

```plaintext
# repeat the whole training procedure twice for best results
# train command 0 in group 3
SEND 't'
SEND 'D'
SEND 'A'
# wait for reply:
# (default timeout is 3s, wait for max 1s more then abort)
result = RECEIVE

IF RECEIVE = 'o' THEN
    # training successful
    OK
ELSE IF result = 'r' THEN
    # training saved, but spoken command is similar to
    # another SD command, read which one
    SEND ' '
    command = RECEIVE - 'A'
    # may notify user and erase training or keep it
ELSE IF result = 's' THEN
    # training saved, but spoken command is similar to
    # another SI command (always trigger, may skip reading)
    SEND ' '
    command = RECEIVE - 'A'
    # may notify user and erase training or keep it
ELSE IF result = 't' THEN
ELSE IF result = 'e' THEN
    # error code, ack and read which one
    SEND ' '
    error = (RECEIVE - 'A') * 16
    SEND ' '
    error = error + (RECEIVE - 'A')
    # perform actions according to error
ELSE
    # invalid request or reply
    ERROR
END IF
```

Recognition of an SD command

```plaintext
# start recognition in group 1
SEND 'd'
SEND 'B'
# wait for reply:
result = RECEIVE

IF result = 'r' THEN
    # successful recognition, ack and read result
    SEND ' '
    command = RECEIVE - 'A'
    # perform actions according to command
ELSE IF result = 't' THEN
    # timed out, no word spoken
ELSE IF result = 'e' THEN
    # error code, ack and read which one
    SEND ' '
    error = (RECEIVE - 'A') * 16
    SEND ' '
    error = error + (RECEIVE - 'A')
    # perform actions according to error
ELSE
    # invalid request or reply
    ERROR
END IF
```
Read used command groups

```plaintext
# request mask of groups in use
SEND 'm'
IF NOT RECEIVE = 'k' THEN ERROR
# read mask to 32 bits variable
# in 8 chunks of 4 bits each
SEND ' '
mask = (RECEIVE - 'A') * 2^4
SEND ' '
mask = mask + (RECEIVE - 'A') * 2^8
    ...
SEND ' '
mask = mask + (RECEIVE - 'A') * 2^24
```

Read how many commands in a group

```plaintext
# request command count of group 3
SEND 'c'
SEND 'D'
IF NOT RECEIVE = 'c' THEN ERROR
# ack and read count
SEND ' '
count = RECEIVE - 'A'
IF count = -1 THEN count = 32
```

Read a user defined command group

```plaintext
# dump command 0 in group 3
SEND 'p'
SEND 'D'
SEND 'A'
IF NOT RECEIVE = 'd' THEN ERROR
# read command data
SEND ' '
training = RECEIVE - 'A'
# extract training count (2 for a completely trained command)
tr_count = training AND 7
# extract flags for conflicts (SD or SI)
tr_flags = training AND 24
# read index of conflicting command (same group) if any
SEND ' '
conflict = RECEIVE - 'A'
# read label length
SEND ' '
length = RECEIVE - 'A'
# read label text
FOR i = 0 TO length - 1
    SEND ' '
    label[i] = RECEIVE
# decode digits
IF label[i] = '^' THEN
    SEND ' '
END IF
END FOR
```
Use general purpose I/O pins

```plaintext
# set IO1 pin to logic low level
SEND 'q'
SEND 'B'
SEND 'A'
IF RECEIVE = 'o' THEN OK ELSE ERROR

# set IO2 pin to logic high level
SEND 'q'
SEND 'C'
SEND 'B'
IF RECEIVE = 'o' THEN OK ELSE ERROR

# set IO2 pin as input with strong pull-up and read state
SEND 'q'
SEND 'C'
SEND 'D'
IF NOT RECEIVE = 'p' THEN ERROR
# ack and read logic level
SEND ''
pin_level = RECEIVE - 'A'

# set IO3 pin as high impedance input (reading state is optional)
SEND 'q'
SEND 'D'
SEND 'C'
IF NOT RECEIVE = 'p' THEN ERROR
```

Use custom sound playback

```plaintext
# play a beep at full volume (works with any or no table)
SEND 'w'
SEND 'A'
SEND 'A'
SEND 'P'
IF RECEIVE = 'o' THEN OK ELSE ERROR

# play entry 13 at half volume
SEND 'w'
SEND 'A'
SEND 'N'
SEND 'H'
IF RECEIVE = 'o' THEN OK ELSE ERROR

# play entry 123 (=3*32+26) at max volume
SEND 'w'
SEND 'A' + 3
SEND 'A' + 26
SEND 'A' + 31
IF RECEIVE = 'o' THEN OK ELSE ERROR
```

Read sound table

```plaintext
# dump sound table
SEND 'h'
IF NOT RECEIVE = 'h' THEN ERROR
# read count of entries and name length
SEND ''
count = (RECEIVE - 'A') * 32
SEND ''
count = count + (RECEIVE - 'A')
SEND ''
length = RECEIVE - 'A'
# read name text
FOR i = 0 TO length - 1
SEND '
label[i] = RECEIVE
NEXT
```
## Built-in Command Sets

In the tables below a list of all built-in commands for each supported language, along with group index (trigger or word set), command index and language identifier to use with the communication protocol.

<table>
<thead>
<tr>
<th>Trigger Word set</th>
<th>Command Index</th>
<th>English (US)</th>
<th>Italian</th>
<th>Japanese (Rōmaji)</th>
<th>German</th>
<th>Spanish</th>
<th>French</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>robot</td>
<td>robot</td>
<td>robotto</td>
<td>roboter</td>
<td>robot</td>
<td>robot</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>action</td>
<td>azione</td>
<td>azionazione</td>
<td>aktion</td>
<td>acción</td>
<td>acción</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>move</td>
<td>vai</td>
<td>susu-me</td>
<td>gehe</td>
<td>muevete</td>
<td>bouge</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>turn</td>
<td>gira</td>
<td>magare</td>
<td>wende</td>
<td>gira</td>
<td>tourne</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>run</td>
<td>corri</td>
<td>hashire</td>
<td>lauf</td>
<td>corre</td>
<td>cours</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>look</td>
<td>guarda</td>
<td>miro</td>
<td>schau</td>
<td>mira</td>
<td>regarde</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>attack</td>
<td>attacca</td>
<td>kougeki</td>
<td>attacke</td>
<td>ataca</td>
<td>attaque</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>stop</td>
<td>fermo</td>
<td>tomare</td>
<td>halt</td>
<td>para</td>
<td>arrête</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>left</td>
<td>a sinistra</td>
<td>hidari</td>
<td>nach links</td>
<td>a la izquierda</td>
<td>à gauche</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>right</td>
<td>a destra</td>
<td>migi</td>
<td>nach rechts</td>
<td>a la derecha</td>
<td>à droite</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>up</td>
<td>in alto</td>
<td>ue</td>
<td>hinauf</td>
<td>arriba</td>
<td>vers le haut</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>down</td>
<td>in basso</td>
<td>shita</td>
<td>hinunter</td>
<td>abajo</td>
<td>vers le bas</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>forward</td>
<td>avanti</td>
<td>mae</td>
<td>vorwärts</td>
<td>adelante</td>
<td>en avant</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>backward</td>
<td>indietro</td>
<td>ushiro</td>
<td>rückwärts</td>
<td>atrás</td>
<td>en arrière</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>zero</td>
<td>zero</td>
<td>zero</td>
<td>null</td>
<td>cero</td>
<td>zéro</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>one</td>
<td>uno</td>
<td>ichi</td>
<td>eins</td>
<td>uno</td>
<td>un</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>two</td>
<td>due</td>
<td>ni</td>
<td>zwei</td>
<td>dos</td>
<td>deux</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>three</td>
<td>tre</td>
<td>san</td>
<td>drei</td>
<td>tres</td>
<td>trois</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>four</td>
<td>quattro</td>
<td>yon</td>
<td>vier</td>
<td>cuatro</td>
<td>quatre</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>five</td>
<td>cinque</td>
<td>go</td>
<td>fünf</td>
<td>cinco</td>
<td>cinq</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>six</td>
<td>sei</td>
<td>roku</td>
<td>sechs</td>
<td>seis</td>
<td>six</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>seven</td>
<td>sette</td>
<td>nana</td>
<td>sieben</td>
<td>siete</td>
<td>sept</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>eight</td>
<td>otto</td>
<td>hachi</td>
<td>acht</td>
<td>ocho</td>
<td>huit</td>
</tr>
<tr>
<td></td>
<td>9</td>
<td>nine</td>
<td>nineve</td>
<td>neun</td>
<td>neune</td>
<td>nueve</td>
<td>neuf</td>
</tr>
<tr>
<td></td>
<td>10</td>
<td>ten</td>
<td>dieci</td>
<td>jyuu</td>
<td>zehn</td>
<td>diez</td>
<td>dix</td>
</tr>
</tbody>
</table>
Error codes

Below the list of the most useful error codes that may be returned by training or recognizing commands.

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>03h</td>
<td>ERR_DATA_COL_TOO_NOISY</td>
</tr>
<tr>
<td>04h</td>
<td>ERR_DATA_COL_TOO_SOFT</td>
</tr>
<tr>
<td>05h</td>
<td>ERR_DATA_COL_TOO_LOUD</td>
</tr>
<tr>
<td>06h</td>
<td>ERR_DATA_COL_TOO_SOON</td>
</tr>
<tr>
<td>07h</td>
<td>ERR_DATA_COL_TOO_CHOPPY</td>
</tr>
<tr>
<td>11h</td>
<td>ERR_RECOG_FAIL</td>
</tr>
<tr>
<td>12h</td>
<td>ERR_RECOG_LOW_CONF</td>
</tr>
<tr>
<td>13h</td>
<td>ERR_RECOG_MID_CONF</td>
</tr>
<tr>
<td>14h</td>
<td>ERR_RECOG_BAD_TEMPLATE</td>
</tr>
<tr>
<td>17h</td>
<td>ERR_RECOG_DURATION</td>
</tr>
<tr>
<td>31h</td>
<td>ERR_RP_BAD_LEVEL</td>
</tr>
<tr>
<td>38h</td>
<td>ERR_RP_NO_MSG</td>
</tr>
<tr>
<td>39h</td>
<td>ERR_RP_MSG_EXISTS</td>
</tr>
<tr>
<td>4Ah</td>
<td>ERR_SYNTH_BAD_VERSION</td>
</tr>
<tr>
<td>4Eh</td>
<td>ERR_SYNTH_BAD_MSG</td>
</tr>
<tr>
<td>80h</td>
<td>ERR_CUSTOM_NOTA</td>
</tr>
<tr>
<td>81h</td>
<td>ERR_CUSTOM_INVALID</td>
</tr>
</tbody>
</table>

The first group of codes (03h - 07h) is due to errors in the way of speaking to the EasyVR or disturbances in the acquired audio signal that may depend on the surrounding environment.

The second group (11h - 13h) indicates an insufficient score of the recognized word (from lowest to highest). Acceptance of lower score results may be allowed by lowering the “knob” or “level” settings, respectively for built-in and custom commands (see CMD_KNOB and CMD_LEVEL).

A third group of codes (14h - 17h) reports errors in the stored commands that may be due to memory corruption. We suggest you check power level and connections, then erase all the commands in the faulty group and train them again.

The fourth group of codes (31h - 39h) deals with errors in message recording, playback or erase.

The fifth group (4Ah - 4Eh) deals with errors in the compressed sound data, either because the wrong version of the QuickSynthesis™ tool has been used to generate the sound table or because a not supported compression scheme has been selected (or data is generically invalid).

The last group (80h - 81h) contains error codes of the EasyVR module itself. Error code (80h = NOTA) means that a word has been recognized that is not in the specified built-in sets. This is due to how Speaker Independent recognition works and can be ignored. Error code (81h = INVALID) is a generic error reported after data validation and currently used for file-system check-up (message recordings).
Protocol header file

This file “protocol.h” can be used with applications written in the C language. You can download a recent copy from the VeeaR website.

```c
#define PROTOCOL_H
#define CMD_BREAK 'b' // abort recog or ping
#define CMD_S floor // go to power down
#define CMD_MIC_DIST 'k' // set microphone (1=off) distance 2
#define CMD_LEVEL 'v' // set sd level 1
#define CMD_VERIFY_BP 'v' // verify filesystem (1=off) with flags 2 (0=check only, 1=fix)
#define CMD_LANGUAGE 'i' // set si language 1
#define CMD_LIPSYNC 'l' // start real-time lipsync (1=on) with threshold 2-3, timeout 4-5
#define CMD_TIMEOUT 'o' // set timeout 1
#define CMD_REC_IF 1 // do si recog from ws 1
#define CMD_MIC_SI 1 // train si command at group 1 pos 2
#define CMD_TRAILING 1 // set trailing (1=on) silence 2 (0-31 = 100-875 milliseconds)
#define CMD_MODE_SI 1 // insert new command at group 1 pos 2
#define CMD_UNGROUP 1 // remove command at group 1 pos 2
#define CMD_REC_IF 1 // do si recog at group 1 (0 = trigger mixed si/sd)
#define CMD_DUMP_BP 1 // dump message (1=on) at pos 2
#define CMD_ERASE_SI 1 // erase command at group 1 pos 2
#define CMD_NAME_SI 1 // label command at group 1 pos 2 with length 3 name 4
#define CMD_DUMP_SI 1 // provide command count for group 1
#define CMD_DUMP_SI 1 // read command data at group 1 pos 2
#define CMD_PLAY_BP 1 // play recording (1=on) at pos 2 with flags 3
#define CMD_THRESHOLD 1 // get active group mask
#define CMD_RESET_SI 1 // reset all memory (commands/groups and messages), with <1>='R'
#define CMD_RESET_SI 1 // reset only commands/groups, with <1>='D'
#define CMD_RESET_SI 1 // reset only messages, with <1>='M'
#define CMD_RECORD_BP 1 // record message (1=on) at pos 2 with bits 3 and timeout 4
#define CMD_ID 'x' // get version id
#define CMD_DELAY 'y' // set transmit delay 1 (log scale)
#define CMD_BAUDRATE 'a' // set baudrate 1 (bit time, 1=115200)
#define CMD_QUERY_SI 'q' // configure, read or write I/O pin 1 of type 2
#define CMD_PLAY_BP 1 // play recording (1=on) at pos 2 with flags 3
#define CMD_DUMP_BP 1 // dump wave table entries
#define CMD_DUMP_SI 1 // dump si settings for ws 1 (or total ws count if -1)
#define CMD_SEND_SI 1 // send sigramnet token with bits 1 index 2-3 at time 4-5
#define CMD_RECV_SI 1 // receive sigramnet token with bits 1 rejection 2 timeout 3-4
#define CMD_FAST_SI 1 // set sd/si 1 (off) to use fast recognition 2 (0=normal/default, 1=fast)
#define CMD_SERVICE 'r' // send service request
#define SVC_EXPORT_SI 'D' // export si commands to group 1
#define SVC_IMPORT_SI 'I' // import si commands from group 1 as raw
#define SVC_VERIFY_SI 'V' // verify training of imported si commands in group 1
#define STS_ID 'x' // provide version id 1
#define STS_PIN 'p' // return pin state 1
#define STS_TABLE_SI 1 // table entries count 1-2 (10-bit), table name 3-5 (counted string)
#define STS_GRAMMAR 'z' // si grammar: flags 1, word count 2, labels... 3-5 (counted strings)
```

This file can be used with applications written in the C language. You can download a recent copy from the VeeaR website.
```c
#define STS_MESSAGE     'g' // message status <1> (0=empty, 4/8=bits format), length <2-7>

// protocol arguments are in the range 0x40 (-1) to 0x60 (+31) inclusive
#define ARG_MIN     0x40
#define ARG_MAX     0x60
#define ARG_ZERO    0x41
#define ARG_ACK     0x20    // to read more status arguments

A better source of information and a reference protocol implementation for the C/C++ language can be found in the Arduino Library source.
```
EasyVR Arduino Library

The EasyVR library implements the serial communication protocol to manage the EasyVR module and the EasyVR Shield from Arduino boards and controllers and it enables easy access to all the EasyVR features.

Installation

To install the EasyVR library on your Arduino IDE use the menu Sketch > Import Library ... > Add Library and open the released zip archive.

Examples

You can easily open the example sketches included with the EasyVR library from inside the Arduino IDE, using the menu File > Examples > EasyVR and choosing one of the available sketches.

EasyVR library settings

Macros

- #define EASYVR_RX_TIMEOUT
- #define EASYVR_STORAGE_TIMEOUT
- #define EASYVR_WAKE_TIMEOUT
- #define EASYVR_PLAY_TIMEOUT
- #define EASYVR_TOKEN_TIMEOUT

Detailed Description

By defining these symbols before the library include directive, you can alter the default settings used by the library implementation. These settings are available for completeness. The default settings should be appropriate for normal use cases.

Macro Definition Documentation

#define EASYVR_RX_TIMEOUT

Receive timeout (in ms). The maximum time that is spent waiting for a reply from the EasyVR module.

#define EASYVR_STORAGE_TIMEOUT

Reply timeout for storage operations (in ms). The maximum time that is spent waiting for a reply after a command that involves write access to the EasyVR internal storage.

#define EASYVR_WAKE_TIMEOUT

Wakeup maximum delay (in ms). The maximum time that the EasyVR module can spend for waking up from idle states.

#define EASYVR_PLAY_TIMEOUT

Playback maximum duration (in ms). The maximum time that is spent waiting for a synchronous playback operation to complete. Asynchronous playback is not affected.

#define EASYVR_TOKEN_TIMEOUT

Token maximum duration (in ms). The maximum time that is spent by the EasyVR module for sending a SonicNet token and reply.
EasyVR Class Reference

Public Types

- enum ModuleId { VRBOT, EASYVR, EASYVR2, EASYVR2_3, EASYVR3, EASYVR3_1, EASYVR3_2, EASYVR3_3, EASYVR3_4 }
- enum Language { ENGLISH, ITALIAN, JAPANESE, GERMAN, SPANISH, FRENCH }
- enum Group { TRIGGER, PASSWORD }
- enum Wordset { TRIGGER_SET, ACTION_SET, DIRECTION_SET, NUMBER_SET }
- enum Distance { HEADSET, ARMS_LENGTH, FAR_MIC }
- enum Knob { LOOSER, LOOSE, TYPICAL, STRICT, STRICTER }
- enum Level { EASY, NORMAL, HARD, HARDER, HARDEST }
- enum TrailingSilence { TRAILING_MIN, TRAILING_DEFAULT, TRAILING_MAX, TRAILING_100MS, TRAILING_200MS, TRAILING_300MS, TRAILING_400MS, TRAILING_500MS, TRAILING_600MS, TRAILING_700MS, TRAILING_800MS }
- bool addCommand (int8_t group, int8_t index)
- bool removeCommand (int8_t group, int8_t index)
- bool setCommandLabel (int8_t group, int8_t index, const char *name)
- bool eraseCommand (int8_t group, int8_t index)
- bool getGroupMask (uint32_t &mask)
- int8_t getCommandCount (int8_t group)
- bool dumpCommand (int8_t group, int8_t index, char *name, uint8_t &training)
- int8_t getGrammarCount (void)
- bool dumpGrammar (int8_t grammar, uint8_t &flags, uint8_t &count)
- void getNextWordLabel (char *name)
- void trainCommand (int8_t group, int8_t index)
- void recognizeCommand (int8_t group)
- void recognizeWord (int8_t wordset)
- bool hasFinished ()
- int8_t getCommand ()
- int8_t getWord ()
- int16_t getToken ()
- int16_t getError ()
- bool isTimeout ()
- bool isAwakened ()
- bool isConflict ()
- bool isMemoryFull ()
- bool isValid ()
- bool setPinOutput (int8_t pin, int8_t value)
- int8_t getPinInput (int8_t pin, int8_t config)
- void detectToken (int8_t bits, int8_t rejection, uint16_t timeout)
- void sendTokenAsync (int8_t bits, uint8_t token)
- void sendToken (int8_t bits, uint8_t token)
- bool embedToken (int8_t bits, uint8_t token, uint16_t delay)
- void playSoundAsync (int16_t index, int8_t volume)
- bool playSound (int16_t index, int8_t volume)
- bool dumpSoundTable (char *name, int16_t &count)
- bool playPhoneTone (int8_t tone, uint8_t duration)
- bool resetAll (bool wait=true)
- bool resetCommands (bool wait=true)
- bool resetMessages (bool wait=true)
- bool checkMessages ()
- bool fixMessages (bool wait=true)
- void recordMessageAsync (int8_t index, int8_t bits, int8_t timeout)
- void playMessageAsync (int8_t index, int8_t speed, int8_t atten)
- void eraseMessageAsync (int8_t index)
- bool dumpMessage (int8_t index, int8_t &type, int32_t &length)
- bool realtimeLipsync (int16_t threshold, uint8_t timeout)
- bool fetchMouthPosition (int8_t &value)
- bool exportCommand (int8_t group, int8_t index, uint8_t *data)
- bool importCommand (int8_t group, int8_t index, const uint8_t *data)
- bool verifyCommand (int8_t group, int8_t index)
- int bridgeRequested (Stream &port)
- void bridgeLoop (Stream &port)

**Detailed Description**

An implementation of the EasyVR communication protocol.

**Member Enumeration Documentation**

```cpp
enum ModuleId
{
  ModuleId // Module identification number (firmware version)
}```
Enumerator

**VRBOT** Identifies a VRbot module

**EASYVR** Identifies an EasyVR module

**EASYVR2** Identifies an EasyVR module version 2

**EASYVR2_3** Identifies an EasyVR module version 2, firmware revision 3

**EASYVR3** Identifies an EasyVR module version 3, firmware revision 0

**EASYVR3_1** Identifies an EasyVR module version 3, firmware revision 1

**EASYVR3_2** Identifies an EasyVR module version 3, firmware revision 2

**EASYVR3_3** Identifies an EasyVR module version 3, firmware revision 3

**EASYVR3_4** Identifies an EasyVR module version 3, firmware revision 4

```enum Language```

Language to use for recognition of built-in words

**Enumerator**

- **ENGLISH** Uses the US English word sets
- **ITALIAN** Uses the Italian word sets
- **JAPANESE** Uses the Japanese word sets
- **GERMAN** Uses the German word sets
- **SPANISH** Uses the Spanish word sets
- **FRENCH** Uses the French word sets

```enum Group```

Special group numbers for recognition of custom commands

**Enumerator**

- **TRIGGER** The trigger group (shared with built-in trigger word)
- **PASSWORD** The password group (uses speaker verification technology)

```enum Wordset```

Index of built-in word sets

**Enumerator**

- **TRIGGER_SET** The built-in trigger word set
- **ACTION_SET** The built-in action word set
- **DIRECTION_SET** The built-in direction word set
- **NUMBER_SET** The built-in number word set

```enum Distance```

Microphone distance from the user's mouth, used by all recognition technologies

**Enumerator**

- **HEADSET** Nearest range (around 5cm)
- **ARMS_LENGTH** Medium range (from about 50cm to 1m)
- **FAR_MIC** Farthest range (up to 3m)

```enum Knob```

Confidence thresholds for the knob settings, used for recognition of built-in words or custom grammars (not used for the mixed trigger group)

**Enumerator**

- **LOOSER** Lowest threshold, most results reported
- **LOOSE** Lower threshold, more results reported
- **TYPICAL** Typical threshold (default)
- **STRICT** Higher threshold, fewer results reported
- **STRICTER** Highest threshold, fewest results reported

```enum Level```

Strictness values for the level settings, used for recognition of custom commands (not used for the mixed trigger group)
**Enumerators**

- **EASY**  Lowest value, most results reported
- **NORMAL**  Typical value (default)
- **HARD**  Slightly higher value, fewer results reported
- **HARDBER**  Higher value, fewer results reported
- **HARDEST**  Highest value, fewest results reported

**enum TrailingSilence**

Trailing silence settings used for recognition of built-in words or custom grammars (including the mixed trigger group), in a range from 100ms to 875ms in steps of 25ms.

**Enumerator**

- **TRAILING_MIN**  Lowest value (100ms), minimum latency
- **TRAILING_DEF**  Default value (400ms) after power on or reset
- **TRAILING_MAX**  Highest value (875ms), maximum latency
- **TRAILING_100MS**  Silence duration is 100ms
- **TRAILING_200MS**  Silence duration is 200ms
- **TRAILING_300MS**  Silence duration is 300ms
- **TRAILING_400MS**  Silence duration is 400ms
- **TRAILING_500MS**  Silence duration is 500ms
- **TRAILING_600MS**  Silence duration is 600ms
- **TRAILING_700MS**  Silence duration is 700ms
- **TRAILING_800MS**  Silence duration is 800ms

**enum CommandLatency**

Latency settings used for recognition of custom commands or passwords (excluding the mixed trigger group)

**Enumerator**

- **MODE_NORMAL**  Normal settings (default), higher latency
- **MODE_FAST**  Fast settings, better response time

**enum Baudrate**

Constants to use for baudrate settings

**Enumerator**

- **B115200**  115200 bps
- **B57600**  57600 bps
- **B38400**  38400 bps
- **B19200**  19200 bps
- **B9600**  9600 bps (default)

**enum WakeMode**

Constants for choosing wake-up method in sleep mode

**Enumerator**

- **WAKE_ON_CHAR**  Wake up on any character received
- **WAKE_ON_WHISTLE**  Wake up on whistle or any character received
- **WAKE_ON_LOUDSOUND**  Wake up on a loud sound or any character received
- **WAKE_ON_2CLAPS**  Wake up on double hands-clap or any character received
- **WAKE_ON_3CLAPS**  Wake up on triple hands-clap or any character received

**enum ClapSense**

Hands-clap sensitivity for wakeup from sleep mode. Use in combination with **WAKE_ON_2CLAPS** or **WAKE_ON_3CLAPS**

**Enumerator**

- **CLAP_SENSE_LOW**  Lowest threshold
- **CLAP_SENSE_MID**  Typical threshold
- **CLAP_SENSE_HIGH**  Highest threshold
enum PinConfig

Pin configuration options for the extra I/O connector

**Enumerator**
- **OUTPUT_LOW** Pin is a low output (0V)
- **OUTPUT_HIGH** Pin is a high output (3V)
- **INPUT_HIZ** Pin is an high impedance input
- **INPUT_STRONG** Pin is an input with strong pull-up (-10K)
- **INPUT_WEAK** Pin is an input with weak pull-up (-200K)

enum PinNumber

Available pin numbers on the extra I/O connector

**Enumerator**
- **IO1** Identifier of pin IO1
- **IO2** Identifier of pin IO2
- **IO3** Identifier of pin IO3
- **IO4** Identifier of pin IO4 (only EasyVR3)
- **IO5** Identifier of pin IO5 (only EasyVR3)
- **IO6** Identifier of pin IO6 (only EasyVR3)

enum SoundVolume

Some quick volume settings for the sound playback functions (any value in the range 0-31 can be used)

**Enumerator**
- **VOL_MIN** Lowest volume (almost mute)
- **VOL_HALF** Half scale volume (softer)
- **VOL_FULL** Full scale volume (normal)
- **VOL_DOUBLE** Double gain volume (louder)

enum SoundIndex

Special sound index values, always available even when no soundtable is present

**Enumerator**
- **BEEP** Beep sound

enum GrammarFlag

Flags used by custom grammars

**Enumerator**
- **GF_TRIGGER** A bit mask that indicate grammar is a trigger (opposed to commands)

enum RejectionLevel

Noise rejection level for SonicNet token detection (higher value, fewer results)

** Enumerator**
- **REJECTION_MIN** Lowest noise rejection, highest sensitivity
- **REJECTION_AVG** Medium noise rejection, medium sensitivity
- **REJECTION_MAX** Highest noise rejection, lowest sensitivity

enum MessageSpeed

Playback speed for recorded messages

** Enumerator**
- **SPEED_NORMAL** Normal playback speed
- **SPEED_FASTER** Faster playback speed

enum MessageAttenuation

Playback attenuation for recorded messages

** Enumerator**
**ATTEN_NONE**  No attenuation (normalized volume)
**ATTEN_2DB2**  Attenuation of -2.2dB
**ATTEN_4DB5**  Attenuation of -4.5dB
**ATTEN_6DB7**  Attenuation of -6.7dB

`enum MessageType`
Type of recorded message
**Enumerator**
- `MSG_EMPTY`  Empty message slot
- `MSG_8BIT`  Message recorded with 8-bits PCM

`enum LipsyncThreshold`
Threshold for real-time lip-sync
**Enumerator**
- `RTLS_THRESHOLD_DEF`  Default threshold
- `RTLS_THRESHOLD_MAX`  Maximum threshold

`enum ErrorCode`
Error codes used by various functions
**Enumerator**
- `ERR_DATACOL_TOO_LONG`  too long (memory overflow)
- `ERR_DATACOL_TOO_NOISY`  too noisy
- `ERR_DATACOL_TOO_SOFT`  spoke too soft
- `ERR_DATACOL_TOOLOUD`  spoke too loud
- `ERR_DATACOL_TOO_Soon`  spoke too soon
- `ERR_DATACOL_TOO_CHOPPY`  too many segments/too complex
- `ERR_DATACOL_BAD_WEIGHTS`  invalid SI weights
- `ERR_DATACOL_BAD_SETUP`  invalid setup
- `ERR_RECOG_FAIL`  recognition failed
- `ERR_RECOG_LOW_CONF`  recognition result doubtful
- `ERR_RECOG_MID_CONF`  recognition result maybe
- `ERR_RECOG_BAD_TEMPLATE`  invalid SD/SV template
- `ERR_RECOG_BAD_WEIGHTS`  invalid SI weights
- `ERR_RECOG_DURATION`  incompatible pattern durations
- `ERR_T2SI_EXCESS_STATES`  state structure is too big
- `ERR_T2SI_BAD_VERSION`  RSC code version/Grammar ROM dont match
- `ERR_T2SI_OUT_OF_RAM`  reached limit of available RAM
- `ERR_T2SI_UNEXPECTED`  an unexpected error occurred
- `ERR_T2SI_OVERFLOW`  ran out of time to process
- `ERR_T2SI_PARAMETER`  bad macro or grammar parameter
- `ERR_T2SI_NN_TOO_BIG`  layer size out of limits
- `ERR_T2SI_NN_BAD_VERSION`  net structure incompatibility
- `ERR_T2SI_NN_NOT_READY`  initialization not complete
- `ERR_T2SI_NN_BAD_LAYERS`  not correct number of layers
- `ERR_T2SI_TRIG_OOV`  trigger recognized Out Of Vocabulary
- `ERR_T2SI_TOO_SHORT`  utterance was too short
- `ERR_RP_BAD_LEVEL`  play - illegal compression level
- `ERR_RP_NO_MSG`  play, erase, copy - msg doesn't exist
- `ERR_RP_MSG_EXISTS`  rec, copy - msg already exists
- `ERR_SYNTH_BAD_VERSION`  bad release number in speech file
- `ERR_SYNTH_ID_NOT_SET`  (obsolete) bad sentence structure
- `ERR_SYNTH_TOO_MANY_TABLES`  (obsolete) too many talk tables
- `ERR_SYNTH_BAD_SEN`  (obsolete) bad sentence number
- `ERR_SYNTH_BAD_MSG`  bad message data or SX technology files missing
- `ERR_CUSTOM_NOTA`  none of the above (out of grammar)
- `ERR_CUSTOM_INVALID`  invalid data (for memory check)
- `ERR_SW_STACK_OVERFLOW`  no room left in software stack
- `ERR_INTERNAL_T2SI_BAD_SETUP`  T2SI test mode error
**enum BridgeMode**

Type of Bridge mode requested

**Enumerator**

- **BRIDGE_NONE**  Bridge mode has not been requested
- **BRIDGE_NORMAL**  Normal bridge mode (**EasyVR** baudrate 9600)
- **BRIDGE_BOOT**  Bridge mode for **EasyVR** bootloader (baudrate 115200)

**Constructor & Destructor Documentation**

**EasyVR** *(Stream & \textit{s})*

Creates an **EasyVR** object, using a communication object implementing the `#Stream` interface (such as `#HardwareSerial`, or the modified `#SoftwareSerial` and `#NewSoftSerial`).

**Parameters:**

- \textit{s}  the Stream object to use for communication with the **EasyVR** module

**Member Function Documentation**

**bool detect ()**

Detects an **EasyVR** module, waking it from sleep mode and checking it responds correctly.

**Return values:**

- **true** if a compatible module has been found

**bool stop ()**

Interrupts pending recognition or playback operations.

**Return values:**

- **true** if the request is satisfied and the module is back to ready

**int8_t getID ()**

Gets the module identification number (firmware version).

**Return values:**

- **integer** is one of the values in `ModuleId`

**bool setLanguage (int8_t \textit{lang})**

Sets the language to use for recognition of built-in words.

**Parameters:**

- \textit{lang}  (0-5) is one of values in `Language`

**Return values:**

- **true** if the operation is successful

**bool setTimeout (int8_t \textit{seconds})**

Sets the timeout to use for any recognition task.

**Parameters:**

- \textit{seconds}  (0-31) is the maximum time the module keep listening for a word or a command

**Return values:**

- **true** if the operation is successful
bool setMicDistance (int8_t dist)
Sets the operating distance of the microphone. This setting represents the distance between the
microphone and the user’s mouth, in one of three possible configurations.
Parameters:
- dist (1-3) is one of values in Distance
Return values:
- true if the operation is successful

bool setKnob (int8_t knob)
Sets the confidence threshold to use for recognition of built-in words or custom grammars.
Parameters:
- knob (0-4) is one of values in Knob
Return values:
- true if the operation is successful

bool setTrailingSilence (int8_t dur)
Sets the trailing silence duration for recognition of built-in words or custom grammars.
Parameters:
- dur (0-31) is the silence duration as defined in TrailingSilence
Return values:
- true if the operation is successful

bool setLevel (int8_t level)
Sets the strictness level to use for recognition of custom commands.
Parameters:
- level (1-5) is one of values in Level
Return values:
- true if the operation is successful

bool setCommandLatency (int8_t mode)
Enables or disables fast recognition for custom commands and passwords. Fast SD/SV recognition can
improve response time.
Parameters:
- mode (0-1) is one of the values in CommandLatency
Return values:
- true if the operation is successful

bool setDelay (uint16_t millis)
Sets the delay before any reply of the module.
Parameters:
- millis (0-1000) is the delay duration in milliseconds, rounded to 10 units in range 10-100 and to 100 units in range 100-1000.
Return values:

| True         | if the operation is successful |

**bool changeBaudrate (int8_t baud)**

Sets the new communication speed. You need to modify the baudrate of the underlying Stream object accordingly, after the function returns successfully.

Parameters:

| baud | is one of values in Baudrate |

Return values:

| True         | if the operation is successful |

**bool sleep (int8_t mode)**

Puts the module in sleep mode.

Parameters:

| mode | is one of values in WakeMode, optionally combined with one of the values in ClapSense |

Return values:

| True         | if the operation is successful |

**bool addCommand (int8_t group, int8_t index)**

Adds a new custom command to a group.

Parameters:

| group | (0-16) is the target group, or one of the values in #Groups |
| index | (0-31) is the index of the command within the selected group |

Return values:

| True         | if the operation is successful |

**bool removeCommand (int8_t group, int8_t index)**

Removes a custom command from a group.

Parameters:

| group | (0-16) is the target group, or one of the values in #Groups |
| index | (0-31) is the index of the command within the selected group |

Return values:

| True         | if the operation is successful |

**bool setCommandLabel (int8_t group, int8_t index, const char * name)**

Sets the name of a custom command.

Parameters:

| group | (0-16) is the target group, or one of the values in #Groups |
| index | (0-31) is the index of the command within the selected group |
| name  | is a string containing the label to be assigned to the specified command |
Return values:

| true | if the operation is successful |

bool eraseCommand (int8_t group, int8_t index)

Erases the training data of a custom command.

Parameters:

<table>
<thead>
<tr>
<th>group</th>
<th>(0-16) is the target group, or one of the values in #Groups</th>
</tr>
</thead>
<tbody>
<tr>
<td>index</td>
<td>(0-31) is the index of the command within the selected group</td>
</tr>
</tbody>
</table>

Return values:

| true | if the operation is successful |

bool getGroupMask (uint32_t & mask)

Gets a bit mask of groups that contain at least one command.

Parameters:

| mask | is a variable to hold the group mask when the function returns |

Return values:

| true | if the operation is successful |

int8_t getCommandCount (int8_t group)

Gets the number of commands in the specified group.

Parameters:

| group | (0-16) is the target group, or one of the values in #Groups |

Return values:

| integer | is the count of commands (negative in case of errors) |

bool dumpCommand (int8_t group, int8_t index, char * name, uint8_t & training)

Retrieves the name and training data of a custom command.

Parameters:

<table>
<thead>
<tr>
<th>group</th>
<th>(0-16) is the target group, or one of the values in #Groups</th>
</tr>
</thead>
<tbody>
<tr>
<td>index</td>
<td>(0-31) is the index of the command within the selected group</td>
</tr>
<tr>
<td>name</td>
<td>points to an array of at least 32 characters that holds the command label when the function returns</td>
</tr>
<tr>
<td>training</td>
<td>is a variable that holds the training count when the function returns. Additional information about training is available through the functions isConflict() and getWord() or getCommand()</td>
</tr>
</tbody>
</table>

Return values:

| true | if the operation is successful |

int8_t getGrammarsCount (void)

Gets the total number of grammars available, including built-in and custom.

Return values:

| integer | is the count of grammars (negative in case of errors) |
bool dumpGrammar (int8_t grammar, uint8_t & flags, uint8_t & count)

Retrieves the contents of a built-in or a custom grammar. Command labels contained in the grammar can be obtained by calling getNextWordLabel()

Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>grammar</td>
<td>(0-31) is the target grammar, or one of the values in Wordset</td>
</tr>
<tr>
<td>flags</td>
<td>is a variable that holds some grammar flags when the function returns. See GrammarFlag</td>
</tr>
<tr>
<td>count</td>
<td>is a variable that holds the number of words in the grammar when the function returns.</td>
</tr>
</tbody>
</table>

Return values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>true</td>
<td>if the operation is successful</td>
</tr>
</tbody>
</table>

bool getNextWordLabel (char * name)

Retrieves the name of a command contained in a custom grammar. It must be called after dumpGrammar()

Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>points to an array of at least 32 characters that holds the command label when the function returns</td>
</tr>
</tbody>
</table>

Return values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>true</td>
<td>if the operation is successful</td>
</tr>
</tbody>
</table>

void trainCommand (int8_t group, int8_t index)

Starts training of a custom command. Results are available after hasFinished() returns true.

Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>group</td>
<td>(0-16) is the target group, or one of the values in #Groups</td>
</tr>
<tr>
<td>index</td>
<td>(0-31) is the index of the command within the selected group</td>
</tr>
</tbody>
</table>

Note:

The module is busy until training completes and it cannot accept other commands. You can interrupt training with stop().

void recognizeCommand (int8_t group)

Starts recognition of a custom command. Results are available after hasFinished() returns true.

Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>group</td>
<td>(0-16) is the target group, or one of the values in #Groups</td>
</tr>
</tbody>
</table>

Note:

The module is busy until recognition completes and it cannot accept other commands. You can interrupt recognition with stop().

void recognizeWord (int8_t wordset)

Starts recognition of a built-in word. Results are available after hasFinished() returns true.

Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>wordset</td>
<td>(0-3) is the target word set, or one of the values in Wordset, (4-31) is the target custom grammar, if present</td>
</tr>
</tbody>
</table>
Note:
The module is busy until recognition completes and it cannot accept other commands. You can interrupt recognition with `stop()`.

```c
bool hasFinished()
```
Polls the status of on-going recognition, training or asynchronous playback tasks.

Return values:

| `true` | if the operation has completed |

```c
int8_t getCommand()
```
Gets the recognised command index if any.

Return values:

| (0-31) | is the command index if recognition is successful, (-1) if no command has been recognized or an error occurred |

```c
int8_t getWord()
```
Gets the recognised word index if any, from built-in sets or custom grammars.

Return values:

| (0-31) | is the command index if recognition is successful, (-1) if no built-in word has been recognized or an error occurred |

```c
int16_t getToken()
```
Gets the index of the received SonicNet token if any.

Return values:

| `integer` | is the index of the received SonicNet token (0-255 for 8-bit tokens or 0-15 for 4-bit tokens) if detection was successful, (-1) if no token has been received or an error occurred |

```c
int16_t getError()
```
Gets the last error code if any.

Return values:

| (0-255) | is the error code, (-1) if no error occurred |

```c
bool isTimeout()
```
Retrieves the timeout indicator.

Return values:

| `true` | if a timeout occurred |

```c
bool isAwakened()
```
Retrieves the wake-up indicator (only valid after `hasFinished()` has been called).

Return values:

| `true` | if the module has been awakened from sleep mode |

```c
bool isConflict()
```
Retrieves the conflict indicator.
Return values:

<table>
<thead>
<tr>
<th>bool isMemoryFull ()</th>
<th>Retrieves the memory full indicator (only valid after addCommand() returned false).</th>
</tr>
</thead>
<tbody>
<tr>
<td>false</td>
<td>if a command could not be added because of memory size constraints (up to 32 custom commands can be created)</td>
</tr>
</tbody>
</table>

Return values:

<table>
<thead>
<tr>
<th>bool isInvalid ()</th>
<th>Retrieves the invalid protocol indicator.</th>
</tr>
</thead>
<tbody>
<tr>
<td>false</td>
<td>if an invalid sequence has been detected in the communication protocol</td>
</tr>
</tbody>
</table>

Return values:

<table>
<thead>
<tr>
<th>bool setPinOutput (int8_t pin, int8_t value)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configures an I/O pin as an output and sets its value</td>
</tr>
<tr>
<td>Parameters:</td>
</tr>
<tr>
<td>pin (1-3) is one of values in PinNumber</td>
</tr>
<tr>
<td>pin (0-1) is one of the output values in PinConfig, or Arduino style HIGH and LOW macros</td>
</tr>
<tr>
<td>Return values:</td>
</tr>
<tr>
<td>true if the operation is successful</td>
</tr>
</tbody>
</table>

Return values:

<table>
<thead>
<tr>
<th>int8_t getPinInput (int8_t pin, int8_t config)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configures an I/O pin as an input with optional pull-up and return its value</td>
</tr>
<tr>
<td>Parameters:</td>
</tr>
<tr>
<td>pin (1-3) is one of values in PinNumber</td>
</tr>
<tr>
<td>pin (2-4) is one of the input values in PinConfig</td>
</tr>
<tr>
<td>Return values:</td>
</tr>
<tr>
<td>integer is the logical value of the pin</td>
</tr>
</tbody>
</table>

Return values:

<table>
<thead>
<tr>
<th>void detectToken (int8_t bits, int8_t rejection, uint16_t timeout)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starts listening for a SonicNet token. Manually check for completion with hasFinished().</td>
</tr>
<tr>
<td>Parameters:</td>
</tr>
<tr>
<td>bits (4 or 8) specifies the length of received tokens</td>
</tr>
<tr>
<td>rejection (0-2) specifies the noise rejection level, it can be one of the values in RejectionLevel</td>
</tr>
<tr>
<td>timeout (1-28090) is the maximum time in milliseconds to keep listening for a valid token or (0) to listen without time limits.</td>
</tr>
</tbody>
</table>

Note:

The module is busy until token detection completes and it cannot accept other commands. You can interrupt listening with stop().
void sendTokenAsync (int8_t bits, uint8_t token)

Starts immediate playback of a SonicNet token. Manually check for completion with hasFinished().

Parameters:

<table>
<thead>
<tr>
<th>bits</th>
<th>(4 or 8) specifies the length of transmitted token</th>
</tr>
</thead>
<tbody>
<tr>
<td>token</td>
<td>is the index of the SonicNet token to play (0-255 for 8-bit tokens or 0-15 for 4-bit tokens)</td>
</tr>
</tbody>
</table>

Note:

The module is busy until playback completes and it cannot accept other commands. You can interrupt playback with stop().

bool sendToken (int8_t bits, uint8_t token)

Plays a SonicNet token and waits for completion.

Parameters:

<table>
<thead>
<tr>
<th>bits</th>
<th>(4 or 8) specifies the length of transmitted token</th>
</tr>
</thead>
<tbody>
<tr>
<td>token</td>
<td>is the index of the SonicNet token to play (0-255 for 8-bit tokens or 0-15 for 4-bit tokens)</td>
</tr>
</tbody>
</table>

Return values:

| true   | if the operation is successful |

bool embedToken (int8_t bits, uint8_t token, uint16_t delay)

Schedules playback of a SonicNet token after the next sound starts playing.

Parameters:

<table>
<thead>
<tr>
<th>bits</th>
<th>(4 or 8) specifies the length of transmitted token</th>
</tr>
</thead>
<tbody>
<tr>
<td>token</td>
<td>is the index of the SonicNet token to play (0-255 for 8-bit tokens or 0-15 for 4-bit tokens)</td>
</tr>
<tr>
<td>delay</td>
<td>(1-28090) is the time in milliseconds at which to send the token, since the beginning of the next sound playback</td>
</tr>
</tbody>
</table>

Return values:

| true   | if the operation is successful |

Note:

The scheduled token remains valid for one operation only, so you have to call playSound() or playSoundAsync() immediately after this function.

void playSoundAsync (int16_t index, int8_t volume)

Starts playback of a sound from the sound table. Manually check for completion with hasFinished().

Parameters:

<table>
<thead>
<tr>
<th>index</th>
<th>is the index of the target sound in the sound table</th>
</tr>
</thead>
<tbody>
<tr>
<td>volume</td>
<td>(0-31) may be one of the values in SoundVolume</td>
</tr>
</tbody>
</table>

Note:

The module is busy until playback completes and it cannot accept other commands. You can interrupt playback with stop().

bool playSound (int16_t index, int8_t volume)

Plays a sound from the sound table and waits for completion.
Parameters:

<table>
<thead>
<tr>
<th>parameter</th>
<th>description</th>
</tr>
</thead>
<tbody>
<tr>
<td>index</td>
<td>is the index of the target sound in the sound table</td>
</tr>
<tr>
<td>volume</td>
<td>(0-31) may be one of the values in SoundVolume</td>
</tr>
</tbody>
</table>

Return values:

<table>
<thead>
<tr>
<th>result</th>
<th>description</th>
</tr>
</thead>
<tbody>
<tr>
<td>true</td>
<td>if the operation is successful</td>
</tr>
</tbody>
</table>

Note:
To alter the maximum time for the wait, define the EASYVR_PLAY_TIMEOUT macro before including the EasyVR library.

`bool dumpSoundTable (char * name, int16_t & count)`

Retrieves the name of the sound table and the number of sounds it contains

Parameters:

<table>
<thead>
<tr>
<th>parameter</th>
<th>description</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>points to an array of at least 32 characters that holds the sound table label when the function returns</td>
</tr>
<tr>
<td>count</td>
<td>is a variable that holds the number of sounds when the function returns</td>
</tr>
</tbody>
</table>

Return values:

<table>
<thead>
<tr>
<th>result</th>
<th>description</th>
</tr>
</thead>
<tbody>
<tr>
<td>true</td>
<td>if the operation is successful</td>
</tr>
</tbody>
</table>

`bool playPhoneTone (int8_t tone, uint8_t duration)`

Plays a phone tone and waits for completion

Parameters:

<table>
<thead>
<tr>
<th>parameter</th>
<th>description</th>
</tr>
</thead>
<tbody>
<tr>
<td>tone</td>
<td>is the index of the tone (0-9 for digits, 10 for '*' key, 11 for '#' key and 12-15 for extra keys 'A' to 'D', -1 for the dial tone)</td>
</tr>
<tr>
<td>duration</td>
<td>(1-32) is the tone duration in 40 milliseconds units, or in seconds for the dial tone</td>
</tr>
</tbody>
</table>

Return values:

<table>
<thead>
<tr>
<th>result</th>
<th>description</th>
</tr>
</thead>
<tbody>
<tr>
<td>true</td>
<td>if the operation is successful</td>
</tr>
</tbody>
</table>

`bool resetAll (bool wait = true)`

Empties internal memory for custom commands/groups and messages.

Parameters:

<table>
<thead>
<tr>
<th>parameter</th>
<th>description</th>
</tr>
</thead>
<tbody>
<tr>
<td>wait</td>
<td>specifies whether to wait until the operation is complete (or times out)</td>
</tr>
</tbody>
</table>

Return values:

<table>
<thead>
<tr>
<th>result</th>
<th>description</th>
</tr>
</thead>
<tbody>
<tr>
<td>true</td>
<td>if the operation is successful</td>
</tr>
</tbody>
</table>

Note:
It will take some time for the whole process to complete (EasyVR3 is faster) and it cannot be interrupted. During this time the module cannot accept any other command. The sound table and custom grammars data is not affected.

`bool resetCommands (bool wait = true)`

Empties internal memory for custom commands/groups only. Messages are not affected.
Parameters:

<table>
<thead>
<tr>
<th>bool resetMessages (bool wait = true)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Empties internal memory used for messages only. Commands/groups are not affected.</td>
</tr>
<tr>
<td>Parameters:</td>
</tr>
<tr>
<td>wait specifies whether to wait until the operation is complete (or times out)</td>
</tr>
<tr>
<td>Return values:</td>
</tr>
<tr>
<td>true if the operation is successful</td>
</tr>
<tr>
<td>Note:</td>
</tr>
<tr>
<td>It will take some time for the whole process to complete (EasyVR3 is faster) and it cannot be interrupted. During this time the module cannot accept any other command. The sound table and custom grammars data is not affected.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>bool checkMessages ()</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performs a memory check for consistency.</td>
</tr>
<tr>
<td>Return values:</td>
</tr>
<tr>
<td>true if the operation is successful</td>
</tr>
<tr>
<td>Note:</td>
</tr>
<tr>
<td>If a memory write or erase operation does not complete due to unexpected conditions, like power losses, the memory contents may be corrupted. When the check fails getError() returns ERR_CUSTOM_INVALID.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>bool fixMessages (bool wait = true)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performs a memory check and attempt recovery if necessary. Incomplete data will be erased. Custom commands/groups are not affected.</td>
</tr>
<tr>
<td>Parameters:</td>
</tr>
<tr>
<td>wait specifies whether to wait until the operation is complete (or times out)</td>
</tr>
<tr>
<td>Return values:</td>
</tr>
<tr>
<td>true if the operation is successful</td>
</tr>
<tr>
<td>Note:</td>
</tr>
<tr>
<td>It will take some time for the whole process to complete (several seconds) and it cannot be interrupted. During this time the module cannot accept any other command. The sound table and custom grammars data is not affected.</td>
</tr>
</tbody>
</table>
void recordMessageAsync (int8_t index, int8_t bits, int8_t timeout)

Starts recording a message. Manually check for completion with hasFinished().

Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>index</td>
<td>(0-31) is the index of the target message slot</td>
</tr>
<tr>
<td>bits</td>
<td>(8) specifies the audio format (see MessageType)</td>
</tr>
<tr>
<td>timeout</td>
<td>(0-31) is the maximum recording time (0=infinite)</td>
</tr>
</tbody>
</table>

Note:
The module is busy until recording times out or the end of memory is reached. You can interrupt an ongoing recording with stop().

void playMessageAsync (int8_t index, int8_t speed, int8_t atten)

Starts playback of a recorded message. Manually check for completion with hasFinished().

Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>index</td>
<td>(0-31) is the index of the target message slot</td>
</tr>
<tr>
<td>speed</td>
<td>(0-1) may be one of the values in MessageSpeed</td>
</tr>
<tr>
<td>atten</td>
<td>(0-3) may be one of the values in MessageAttenuation</td>
</tr>
</tbody>
</table>

Note:
The module is busy until playback completes and it cannot accept other commands. You can interrupt playback with stop().

void eraseMessageAsync (int8_t index)

Erases a recorded message. Manually check for completion with hasFinished().

Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>index</td>
<td>(0-31) is the index of the target message slot</td>
</tr>
</tbody>
</table>

Return values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>true</td>
<td>if the operation is successful</td>
</tr>
</tbody>
</table>

bool dumpMessage (int8_t index, int8_t & type, int32_t & length)

Retrieves the type and length of a recorded message

Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>index</td>
<td>(0-31) is the index of the target message slot</td>
</tr>
<tr>
<td>type</td>
<td>(0,8) is a variable that holds the message format when the function returns (see MessageType)</td>
</tr>
<tr>
<td>length</td>
<td>is a variable that holds the message length in bytes when the function returns</td>
</tr>
</tbody>
</table>

Return values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>true</td>
<td>if the operation is successful</td>
</tr>
</tbody>
</table>

Note:
The specified message may have errors. Use getError() when the function fails, to know the reason of the failure.

bool realtimeLipsync (int16_t threshold, uint8_t timeout)

Starts real-time lip-sync on the input voice signal. Retrieve output values with fetchMouthPosition() or abort with stop().
Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>threshold</strong></td>
<td>(0-1023) is a measure of the strength of the input signal below which the mouth is considered to be closed (see LipsyncThreshold, adjust based on microphone settings, distance and background noise)</td>
</tr>
<tr>
<td><strong>timeout</strong></td>
<td>(0-255) is the maximum duration of the function in seconds, 0 means infinite</td>
</tr>
</tbody>
</table>

Return values:

<table>
<thead>
<tr>
<th>Boolean</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>true</code></td>
<td>if the operation is successfully started</td>
</tr>
</tbody>
</table>

`bool fetchMouthPosition (int8_t & value)`

Retrieves the current mouth position during lip-sync.

Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>value</strong></td>
<td>(0-31) is filled in with the current mouth opening position</td>
</tr>
</tbody>
</table>

Return values:

<table>
<thead>
<tr>
<th>Boolean</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>true</code></td>
<td>if the operation is successful, false if lip-sync has finished</td>
</tr>
</tbody>
</table>

`bool exportCommand (int8_t group, int8_t index, uint8_t * data)`

Retrieves all internal data associated to a custom command.

Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>group</strong></td>
<td>(0-16) is the target group, or one of the values in #Groups</td>
</tr>
<tr>
<td><strong>index</strong></td>
<td>(0-31) is the index of the command within the selected group</td>
</tr>
<tr>
<td><strong>data</strong></td>
<td>points to an array of at least 258 bytes that holds the command raw data</td>
</tr>
</tbody>
</table>

Return values:

<table>
<thead>
<tr>
<th>Boolean</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>true</code></td>
<td>if the operation is successful</td>
</tr>
</tbody>
</table>

`bool importCommand (int8_t group, int8_t index, const uint8_t * data)`

Overwrites all internal data associated to a custom command. When commands are imported this way, their training should be tested again with `verifyCommand()`.

Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>group</strong></td>
<td>(0-16) is the target group, or one of the values in #Groups</td>
</tr>
<tr>
<td><strong>index</strong></td>
<td>(0-31) is the index of the command within the selected group</td>
</tr>
<tr>
<td><strong>data</strong></td>
<td>points to an array of at least 258 bytes that holds the command raw data</td>
</tr>
</tbody>
</table>

Return values:

<table>
<thead>
<tr>
<th>Boolean</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>true</code></td>
<td>if the operation is successful</td>
</tr>
</tbody>
</table>

`void verifyCommand (int8_t group, int8_t index)`

Verifies training of a custom command (useful after import). Similarly to `trainCommand()`, you should check results after `hasFinished()` returns true.

Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>group</strong></td>
<td>(0-16) is the target group, or one of the values in #Groups</td>
</tr>
<tr>
<td><strong>index</strong></td>
<td>(0-31) is the index of the command within the selected group</td>
</tr>
</tbody>
</table>

`int bridgeRequested (Stream & port)`

Tests if bridge mode has been requested on the specified port.
Parameters:

| port | is the target serial port (usually the PC serial port) |

Return values:

| non | zero if bridge mode should be started |

Note:

The EasyVR Commander software can request bridge mode when connected to the specified serial port, with a special handshake sequence.

void bridgeLoop(Stream & port)

Performs bridge mode between the EasyVR serial port and the specified port in a continuous loop. It can be aborted by sending a question mark (?) on the target port.

Parameters:

| port | is the target serial port (usually the PC serial port) |
EasyVR Commander

The EasyVR Commander software can be used to easily configure your EasyVR module connected to your PC through a QuickUSB cable, an adapter board, or by using the microcontroller host board with the provided “bridge” program (available for ROBONOVA controller board, Arduino, Parallax Basic Stamp).

You can define groups of commands or passwords and generate a basic code template to handle them. It is required to edit the generated code to implement the application logic, but the template contains all the functions or subroutines to handle the speech recognition tasks.

Getting Started

Connect the QuickUSB cable, an adapter board or a microcontroller host board with a running “bridge” program to your PC, then check that all devices are properly turned on and start the EasyVR Commander. Select the serial port to use from the toolbar or the “File” menu, and then go with the “Connect” command.

There are five kinds of commands in the software (see Figure 3 and Figure 7):

- **Trigger** - special group where you have the built-in SI trigger word “Robot” and you may add one user-defined SD trigger word. Trigger words are used to start the recognition process
- **Group** - where you may add user-defined SD commands, organized in subsets
- **Password** - special group of "voice passwords" (up to 5), using Speaker Verification (SV) technology
- **Wordset** - built-in set of SI commands (for instance in Figure 3 above, the Wordset 1 is selected)
- **Grammar** - custom set of SI commands (created with QuickT2SI™ Lite software).

There are also two other categories of data shown:

- **SoundTable** - list of compressed audio samples (prompts, sounds, etc.) loaded into the module
- **Messages** - run-time sound recordings stored on internal memory

---

6 On some systems the EasyVR Commander can automatically upload the “bridge” program to the host board once connected. That applies to Robonova controller board and Parallax Basic Stamp.
Remote Connections (Advanced Topic)

The EasyVR Commander can also connect to remote systems, typically Linux PCs or Linux embedded systems (such as BeagleBone, Raspberry Pi, etc.), that expose a remote EasyVR module through the network.

To enable this feature (available since v3.12.0) you need to configure the remote system and manually edit the EasyVR Commander settings.

On Linux based systems, you can use either “socat” or “ser2net” utilities to map the serial port where the EasyVR module is physically connected to a TCP port of your choice.

**Attention!** The examples below have been tested with specific versions of the hardware and the software; they might not work for your own combination. Since modifications to the system configuration are required, this topic is recommended for expert users only!

Configuring the Remote System

**Example 1: BeagleBone Black (Rev C)**

- Connect the EasyVR 3 module to UART1 on the BeagleBone expansion headers:

<table>
<thead>
<tr>
<th>EasyVR 3 Module</th>
<th>BeagleBone Black</th>
</tr>
</thead>
<tbody>
<tr>
<td>GND</td>
<td>DGND (P9.1)</td>
</tr>
<tr>
<td>5V or 3V3 (depending on PWR jumper)</td>
<td>VDD_3V3 (P9.3)</td>
</tr>
<tr>
<td>TX</td>
<td>UART1_RXD (P9.26)</td>
</tr>
<tr>
<td>RX</td>
<td>UART1_TXD (P9.24)</td>
</tr>
</tbody>
</table>

  In alternative, you may use an adapter board for mikroBUS interface, like the “mikroBUS Cape” by MikroElektronika, just make sure you set the PWR jumper to the +3V3 position on the EasyVR 3 module and that you plug it in socket 2 or 3 (other sockets use a different UART).

- Install a recent Debian image (e.g. Jessie) on the SD Card or internal eMMC memory
- Run the following commands on a shell prompt (comments start with #):

  ```
  # install ser2net
  sudo apt-get install ser2net

  # permanently map TCP port 6666 to UART1
  echo 6666:raw:0:/dev/ttyO1:9600 8DATABITS NONE 1STOPBIT | sudo tee -a /etc/ser2net.conf

  # enable UART1 pin mux
  echo cape_enable=bone_capemgr.enable_partno=BB-UART1 | sudo tee -a /boot/uEnv.txt

  # reboot
  sudo reboot
  ```

**Example 2: Raspberry Pi Model B+**

- Connect the EasyVR 3 module to the Raspberry Pi expansion header:

<table>
<thead>
<tr>
<th>EasyVR 3 Module</th>
<th>Raspberry Pi</th>
</tr>
</thead>
<tbody>
<tr>
<td>GND</td>
<td>GND (Pin 9)</td>
</tr>
<tr>
<td>5V or 3V3 (depending on PWR jumper)</td>
<td>3.3V (Pin 1)</td>
</tr>
<tr>
<td>TX</td>
<td>UART_RX (Pin 10)</td>
</tr>
<tr>
<td>RX</td>
<td>UART_TX (Pin 8)</td>
</tr>
</tbody>
</table>

  In alternative, you may use an adapter board for mikroBUS interface, like the “PI2 click Shield” by MikroElektronika, just make sure you set the PWR jumper to the +3V3 position on the EasyVR 3 module.
- Install a recent Debian image (e.g. Jessie) on the SD Card or internal e-MMC memory
- Run the following commands on a shell prompt (comments start with #):

```
# install ser2net (and samba to broadcast hostname)
sudo apt-get install ser2net samba

# permanently map TCP port 5555 to UART
echo 5555:raw:0:/dev/serial0:9600 8DATABITS NONE 1STOPBIT | sudo tee -a /etc/ser2net.conf

# enable serial interface without login shell (menu Interfacing Options > Serial > No > Yes)
sudo raspi-config

# reboot
sudo reboot
```

### Configuring the EasyVR Commander

- Locate the folder where the EasyVR Commander settings are stored. Open any Explorer folder, copy-paste this text in the address bar and press Enter:

```
%LocalAppData%\VeeaR\EasyVR Commander
```

- Open the file “Settings.ini” and append the following section at the end:

```
[AddressList]
Count=2
Address0=TCP:raspberrypi,5555
Address1=TCP:beaglebone,6666
```

Those lines reflect the above examples of remote systems configuration and expect that your PC and the remote systems are on the same local network or anyway that the remote systems can be reached via TCP connection to the specified symbolic addresses (numerical IP addresses are also supported).

- Restart the EasyVR Commander for the new settings to become effective. Now you can choose to connect to one of the remote systems you just added, as if they were regular serial ports.

![Figure 4 - Remote connections now available](image-url)
Speech Recognition

The recognition function of the EasyVR works on a single group at a time, so that users need to group together all the commands that they want to be able to use at the same time.

When EasyVR Commander connects to the module, it reads back all the user-defined commands and groups, which are stored into the EasyVR module non-volatile memory.

You can add a new command by first selecting the group in which the command needs to be created and then using the toolbar icons or the “Edit” menu.

A command should be given a label and then it should be trained twice with the user's voice: the user will be guided throughout this process (see Figure 5) when the “Train Command” action is invoked.

**Note:** Only Latin characters and digits can be used for labels, as well as the underscore character.

![Guided training dialog](image)

*Figure 5 - Guided training dialog*

After clicking on “Phase 1” or “Phase 2” buttons, remember you have to start speaking only when you see this little window:

![Speak now...](image)

If any error happens, command training will be cancelled. Errors may happen when the user’s voice is not heard correctly, there is too much background noise or when the second word heard is too different from the first one.

![Alert dialog in case of training conflicts](image)

*Figure 6 - Alert dialog in case of training conflicts*
The software will also alert if a command is too similar to an existing one by specifying the index of the conflicting command in the "Conflict" column. For example, in the following Figure 7 the command "TEST_CMD_ONE" sounds too similar to "TEST_CMDZERO" (i.e. they have been trained with a similar pronunciation).

**Note:** TEST_CMD_ZERO and TEST_CMD_ONE are just examples of labels, you should use label names that reflects the real command that you are going to train.

![Figure 7 - Showing conflicting commands](image)

The current status is displayed in the EasyVR Commander list-view where groups that already contain commands are highlighted in bold.

The selected group of commands can also be tested, by using the icon on the toolbar or the “Tools” menu, to make sure the trained commands can be recognized successfully.

**Note:** If you want to re-train a command you need to erase the previous training first.

**Note:** "Vocal passwords" (Group 16) are much more sensitive to environmental noise and distance from the microphone: be sure to train and to verify the password in similar conditions.
Recognition Settings

The module comes programmed with some default settings that can affect voice recognition. These parameters can be altered in those cases where the default values do not offer the best performance.

![Recognition Settings Interface](image)

Figure 8 - Interface for changing recognition settings

The “Level” and “Knob” parameters affect the way recognition results are evaluated and reported, each one for a different kind of voice recognition algorithm (Speaker Dependent/Verification and Speaker Independent, respectively).

Both these values are used for a sort of acceptance threshold: each word or command recognized is assigned a score by the algorithm, which is compared to the threshold.

In some situations the algorithm may flag a correct result as an error or a low confidence result. In those cases you may try to lower the threshold and allow more results to be reported as correct. The drawback is that even words that were correctly refused before might also be accepted.

The vice-versa is also true: you can increase the threshold to avoid some incorrect words to be reported as good, but then you may also lose a few correct results. So, in the end, you need to find the best compromise.

Ticking “Use “Fast” SD/SV Recognition” will use a faster algorithm for SD and SV recognition. In a similar way, faster SI recognition can be obtained by lowering the Trailing Silence (default is 400 ms).

The last parameter affects the internal microphone pre-amplifier and AGC (Automatic Gain Control) stages and is an indication of the expected operating distance of the microphone from the speaker’s mouth.

**Note:** The EasyVR module is optimized for the default distance setting “Arms Length”. Any other settings may require hardware modifications to the on-board gain resistor.
To change the recognition settings of the currently connected EasyVR device press the “Apply” button. The window is non-modal, so you can test the effects of your changes while leaving it open.

The “Save” button makes the EasyVR Commander remember your settings and automatically apply them to every connected device. The module itself does not store any option.

**Phone Tones Generation (DTMF)**

The EasyVR module is also capable of generating DTMF sounds. This feature can be tested by using the “Dial Tones” command in the “Tools” menu.

![Figure 6 - Interface for generating phone tones](image)

The tone duration can be specified in increments of 40 ms (milliseconds). The dial tone has a fixed duration of 3 seconds (its duration can be modified when programming the EasyVR).
Testing SonicNet™

Another feature available from the “Tools” menu is the “SonicNet™”, a wireless communication protocol based on transmission and detection of special sequences of tones, called “tokens”. Two kinds of tokens can be selected: a short version, with up to 16 different tokens, and a long version that provides up to 256 tokens.

![Figure 7 - Interface for testing SonicNet features](image1)

The EasyVR module can listen for incoming tokens continuously, or for as long as about 28 seconds (specified with a granularity of around 27.5 ms). Another parameter for token detection is the rejection level that specifies the receiver sensitivity: higher rejection means lower sensitivity that is a lower detection rate, and vice-versa.

When the timeout parameter is set to 0, the module will listen continuously and you can use the “Play” button to send a token from your PC soundcard and the “Stop” button to stop listening.

![Figure 9 - Modified interface during continuous listening](image2)
A pop-up window will display the current state of token detection:

![Token Detection Window](image)

Tokens may also be transmitted from the module with the “Send” button. An optional delay parameter can be used to indicate that the token will be mixed with the next sound played from the Soundtable, after the specified amount of time since the playback begins. In this case the SonicNet dialog will close to let you choose a sound to play back.

**Note:** If you want to mix tokens with a compressed audio sample, you must use a compression scheme with a sample rate of 9.3 kHz when building the Soundtable in the QuickSynthesis™ tool.

If the delay is 0, the token is sent out immediately. Other values can be specified up to around 28 seconds of delay (with a granularity of around 27.5 ms).

Finally, you can also export all the tokens of the specified length to some folder on your PC as Wave files (.WAV format) by using the “Generate…” button. You can then use those files to embed SonicNet™ tokens into other software or external sound sources (such as portable players, CDs or DVDs, etc...)

![Export Tokens Dialog](image)

*Figure 10 - Export of 4-bit tokens*
Real-Time Lip-Sync

Another feature available from the “Tools” menu is the “Real-Time Lip-Sync”. In fact, starting from Firmware revision 4, you can use this feature to let your “animatronic” characters “speak” moving their lips. Clicking on “Real-Time Lip-Sync” will open the following window:

![Lip-Sync interface with animated mouth](image)

If you click on “Start” the virtual mouth on the window will start moving in sync with your voice. In real animatronic characters you can use a servo to move their lips.

You can specify a maximum duration (timeout) or leave it running until you click on “Stop”. You may also specify a threshold for the input signal power, below which the mouth is considered closed (silence).

Import and Export of Custom Commands

Starting with firmware revision 4 of the EasyVR 3 module, it is possible to export all the data, including training, of the existing commands and passwords into a file. You can then use that file to import all the commands at once into another module or just as a backup for your commands.

While the module is connected, click on “Export Commands...” under the “File” menu and write the name of the file that will contain the exported commands. In the same way you can select “Import Commands...” and then choose the file with the commands you would like to import.

**Note:** During the Import procedure all the existing commands will be discarded and replaced by the ones contained in the specified file!

During the Import/Export process some feedback is provided with pop-up windows and with the progress bar on the main window.
Using Custom Data

Sound Table

The EasyVR module can play one of the sounds or sentences saved on its internal flash memory. A predefined “beep” sound is also always available, even when no sounds have been downloaded to the module.

The custom sounds are organized in a so-called “sound table” that users can prepare and build with the special QuickSynthesis™ tool. Please refer to this application’s own manual for details about the creation of a sound table. Let’s summarize the basic steps here:

- Prepare the audio files you want to include in the sound table in WAV format, uncompressed 16-bit 22050Hz mono. To create the sound files you may use a free software like Audacity for example (http://audacity.sf.net)
- Open Sensory’s QuickSynthesis™ 5 and create a new project, specifying “RSC4 family”
- Add your WAV files and specify one of the supported compression scheme (see table below)
- Optionally add sentences, by combining basic WAV sounds. That allows you to save memory when you have speech audio files, if they share some pieces (like “You said” + “One”, “You said” + “Two”, and so on)
- Build the project with QuickSynthesis™ and use default settings (“Build linkable module”, “Load in CONST space”, “Load above or at: 0”). You will be asked to recompress new or modified sound files, just confirm and proceed
- Now save your project and build it once again, so that the EasyVR Commander will see that your build is up to date.

The audio compression formats supported by the EasyVR module (from highest to lowest compression rate):

<table>
<thead>
<tr>
<th>Compression Scheme</th>
<th>Available Time (8kHz 15% silence)</th>
<th>Available Time (9.3kHz 15% silence)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SX-2</td>
<td>20.9 minutes</td>
<td>18.1 minutes</td>
</tr>
<tr>
<td>SX-3</td>
<td>18.4 minutes</td>
<td>15.9 minutes</td>
</tr>
<tr>
<td>SX-4</td>
<td>16.3 minutes</td>
<td>14.1 minutes</td>
</tr>
<tr>
<td>SX-5</td>
<td>14.7 minutes</td>
<td>12.6 minutes</td>
</tr>
<tr>
<td>SX-6</td>
<td>13.4 minutes</td>
<td>11.6 minutes</td>
</tr>
<tr>
<td>4-bit ADPCM</td>
<td>209 seconds</td>
<td>N/A</td>
</tr>
<tr>
<td>8-bit PCM</td>
<td>108 seconds</td>
<td>92 seconds</td>
</tr>
</tbody>
</table>

For audio file containing speech, the SX-3 compression is usually a good choice. If you need higher quality try lower compression rates. Please note that due to the sampling rate used, the audio files cannot contain very high frequencies (less than half the sampling rate).
Speaker Independent Custom Vocabularies

The set of built-in Speaker Independent recognition vocabularies can be expanded with custom grammars, that you can create with the QuickT2SI™ tool (a separate license is required to use the software).

When you create a QuickT2SI™ project, you are presented with a list of words or short phrases (also called “commands”) and an optional trigger word/phrase. The so-called “trigger” is a special set that contains only one word or phrase, with an improved recognition performance, that is used as an entry point for any vocal interaction with a device that is continuously listening to the user’s voice.

If you need to use a trigger word, it is important to carefully choose it so that it has good performance, with very few unintended activations and a high recognition rate. When the user says the trigger word followed by a command, the system can discard unintended activations when the trigger is not followed by a command within a short amount of time (usually around 3 seconds). Moreover, there is only one trigger word to listen to, instead of a list of several commands, so the chance to pick up a random command from background noise or talk is also lower, when using a trigger word.

For assistance on using the QuickT2SI™ Software, please refer to the software help file.
Several projects can also be combined together if they are using the same acoustic model (language data) using the Acoustic Model Combiner included with the tool. This is useful if you have many command vocabularies, in order to save space in the EasyVR memory.

**Updating Custom Data**

Once the sound table and/or custom recognition grammars have been created, they can be processed by the EasyVR Commander and downloaded to the module. Note that you must first disconnect from the module and do the steps required to start it in “boot-mode” (see the section *Flash Update*).

Now the command “Update Custom Data” is enabled, either on the toolbar or the “File” menu, and it can be used to start the update process. First you are required to list all the QuickSynthesis™ and QuickT2SI™ projects you want to use. A new file containing the specified custom data will be generated and the contents will be displayed, so that you can verify them before updating the module.

**Note:** The projects must have been built already with the QuickSynthesis™ or the QuickT2SI™ tool, before the custom data generation can be completed successfully. If a recent build is not available you will receive a warning message, the project files can be opened in their respective tools and a fresh build started (make sure the project file has been saved before the build).

Once back in the EasyVR Commander the project can be reloaded by pressing the “Refresh” button. If the process completes successfully, the “Download” button will be enabled and the flash update process can start.

The default format of generated data is suitable for the EasyVR 3. For previous versions of the module or the shield please make sure to check the option “Old Format (EasyVR 2.0)”.

---

Figure 13 - External tool for custom vocabularies
The download process will connect at a higher speed to the EasyVR module, so the “bridge” program running on your host device might not work (in particular Robonova and Basic Stamp cannot be used for this purpose) and you might need a true “serial adapter”.

The full speed used is 230400 bps, but the option “Slow transfer” can be used to reduce it to 115200, for better compatibility with slower serial adapters. One adapter that can go to full speed is the QuickUSB cable. Otherwise any USB/Serial adapter with TTL/CMOS interface can be used for updating the flash. The EasyVR Shield can be used for the download, provided that the mode jumper is in UP or LEO position.

**Note:** Every download will overwrite the previously transferred custom data.

After the download completes, a new connection can be established with the EasyVR module (in “normal-mode”) and the new sounds will be displayed by the EasyVR Commander, in the special group “SoundTable” (the last one in the list with a yellow icon). They can be played back and tested using the “Play Sound” command on the toolbar or in the “Tools” menu. See also how to do that in your application in the code example *Use custom sound playback*.

Custom grammars will be displayed just after the built-in word sets and they work exactly the same way. Trigger words, when specified, will have their own vocabulary with only one entry. You can test and use the custom trigger and command grammars as you do with the built-in ones.

**Note:** The built-in trigger word set is handled in a special way, as it is active also when recognizing from the first user defined command group. This is the only case where SD and SI commands are mixed together and does not apply to custom trigger vocabularies.

---

7 Arduino UNO (and other boards with USB/Serial adapter based on ATMEGA8U2) need the option “Slow transfer” enabled
Message Recording

Starting from firmware Revision 1 of the EasyVR 3 module, it's possible to record up to 32 messages. The communication protocol and Arduino library have been updated accordingly (see related chapters).

The first time you update the module with a firmware with message recording capability, the serial flash memory of the module has to be formatted. The EasyVR Commander will automatically identify a module with the memory to be formatted and will alert you with the following window:

![Figure 15 - Alert for corrupted message storage](image)

The same window could appear in case the memory is corrupted for any reason (i.e. the module has been switched off while recording or erasing a message).

With EasyVR Commander v3.10.0 and above you can also record, play and erase messages by clicking on the specific buttons, after selecting the "Messages" group in the Group List.

In order to record a message you have to press the "record button" to start recording and press it again to stop.

![Figure 16 - User interface for messages](image)
Updating Firmware

The EasyVR firmware can be updated in a similar way to custom data by using the command “Update Firmware...” from the “Help” menu. Note that you must first disconnect from the module and do the steps required to start it in “boot-mode” (see the section Flash Update).

Firmware files can be found in the EasyVR Commander installation folder (default C:\Program Files (x86)\VeeaR\EasyVR Commander), for instance file “EasyVR3_FW_Rev0.EVRFW” is the EasyVR 3 firmware Revision 0. Please be sure to get the most up-to-date EasyVR Commander in order to have to most up-to-date available firmware as well.

The specified file will be verified as an official firmware release and basic version information will be displayed. If the firmware passes the verification step, then the “Download” button will be enabled.

![Figure 17 - Interface for updating EasyVR firmware](image)

**Note:** After a new firmware is downloaded to the module, the custom data already present (sound table and grammars) is erased and it must be downloaded again if necessary.

Important Upgrade Notice

Since EasyVR 3 Firmware Revision 5 the internal memory layout for user data has changed, in order to accommodate space for 32 more SD commands, increasing the total maximum number of commands to 64. The space previously reserved for live message recordings has therefore been reduced by around 20%.

When upgrading firmware to Revision 5 or later (and also if going back to a previous version) you should follow these steps:

- Use the “Export Commands” function to save a backup of your SD/SV commands (optional);
- Erase all data from user memory, with the “Reset All” command (all the recorded messages and user commands will be deleted);
- Perform the firmware upgrade to Revision 5;
- Use the “Import Commands” feature to restore commands from the previous backup (optional).
QuickUSB Adapter Cable

Product Description

The QuickUSB is a USB-to-UART adapter cable, easy to use and supported on all the major operating systems.

It plugs into a standard USB port and brings all the UART signals to a convenient 6-pin 2mm pitch female connector (Hirose DF11 Series).

QuickUSB Features

- USB 2.0 Full Speed interface
- Full UART (RX/TX and RTS/CTS) at 3.3V
- Data transfer rates from 300 bps to 3 Mbps
- Extended operating temperature range: -40°C to 85°C
- Cable Length: 1.8 m

Technical Specifications

Drawings and Schematics

<table>
<thead>
<tr>
<th>Pin</th>
<th>Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>I</td>
<td>RXD</td>
<td>Asynchronous Data Receive line</td>
</tr>
<tr>
<td>2</td>
<td>O</td>
<td>RTS#</td>
<td>Request To Send flow control line</td>
</tr>
<tr>
<td>3</td>
<td>GND</td>
<td>GND</td>
<td>Power and signal ground</td>
</tr>
<tr>
<td>4</td>
<td>Power</td>
<td>VCC</td>
<td>5V power output (USB VBUS)</td>
</tr>
<tr>
<td>5</td>
<td>O</td>
<td>TXD</td>
<td>Asynchronous Data Transmit line</td>
</tr>
<tr>
<td>6</td>
<td>I</td>
<td>CTS#</td>
<td>Clear To Send flow control line</td>
</tr>
</tbody>
</table>
Operating Conditions

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Parameter</th>
<th>Min</th>
<th>Typ</th>
<th>Max</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>VCC</td>
<td>DC Power Output (VBUS) *</td>
<td>4.5</td>
<td>5.0</td>
<td>5.5</td>
<td>V</td>
</tr>
<tr>
<td>Ta</td>
<td>Ambient Operating Temperature Range</td>
<td>-40</td>
<td>25</td>
<td>85</td>
<td>°C</td>
</tr>
</tbody>
</table>

(*) Output current might be limited by USB Host and internal adapter settings

Electrical Characteristics

These are applicable to pins RXD, CTS.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Parameter</th>
<th>Min</th>
<th>Typ</th>
<th>Max</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>VIH</td>
<td>Input High Voltage</td>
<td>1.5</td>
<td>3.3</td>
<td></td>
<td>V</td>
</tr>
<tr>
<td>VIL</td>
<td>Input Low Voltage</td>
<td>0.0</td>
<td>1.0</td>
<td></td>
<td>V</td>
</tr>
</tbody>
</table>

These are applicable to pin TXD, RTS.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Parameter</th>
<th>Min</th>
<th>Typ</th>
<th>Max</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>VOH</td>
<td>Output High Voltage (IOH = -1 mA)</td>
<td>2.2</td>
<td>2.7</td>
<td>3.2</td>
<td>V</td>
</tr>
<tr>
<td>VOL</td>
<td>Output Low Voltage (IOL = 2 mA)</td>
<td>0.3</td>
<td>0.5</td>
<td></td>
<td>V</td>
</tr>
</tbody>
</table>

Quick Start Instructions

Software Setup

The first time you want to use the QuickUSB you need to install the required software drivers for your Operating System. Please follow this procedure (one-time only):

1. Plug the USB end of the cable to your PC and leave the other end unconnected
2. If you have a recent OS version please allow the system to search for updated drivers:
   a. If the setup was successful, unplug the cable, the procedure is complete
   b. If the setup failed, unplug the cable and continue to the next step
3. Download the latest official drivers for your OS version from the FTDI VCP Drivers page
4. Run the driver setup package, or follow any alternate installation procedure accompanying the download
5. After the software setup is complete go back to step 1 above, the OS should now be able to find the required drivers automatically

Using the Adapter

Once the required software drivers are correctly installed and configured by the Operating System, you should not need to repeat the above procedure anymore.

Just plug the cable on the target board first, then plug the USB connector to a free port on your PC.

The adapter will be visible as a new USB Serial Port device and a virtual COM port on Windows. This COM port number is the one to use with the EasyVR Commander.
How to get support

Please feel free to contact us with any questions, queries or suggestions. If your question is about technical support or troubleshooting for one of our products, we kindly ask you to first check our FAQ for a possible solution: http://www.veear.eu/faq

If you cannot find an existing solution on the FAQ, please contact us using the contact form on our website at http://www.veear.eu/support. The more detail you provide, the better support we can give.

VeeaR © RoboTech srl, all rights reserved.

All VeeaR branded boards and software are manufactured by RoboTech srl

RoboTech srl assumes no responsibility for any errors, which may appear in this manual. Furthermore, RoboTech srl reserves the right to alter the hardware, software, and/or specifications detailed herein at any time without notice, and does not make any commitment to update the information contained herein. RoboTech srl products are not authorized for use as critical components in life support devices or systems.